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1 Introduction 

The Oasys Ltd LS-DYNA Environment 20.0 suite, dated March 2023, is a full release which 
supersedes all previous releases. 

This document lists the enhancements that have been made during development, and the bugs 
that have been fixed (since 19.1). Each ‘Case ID’ referred to in these lists is unique and should 
be cited if more information or clarification are required. 

 

1.1 Compatibility with LS-DYNA releases 

The 20.0 release has been used and tested with LS-DYNA version R14 and the current 
development version. It supports all the keywords in volumes I, II and III of the released R13.0 
User’s Manual. Many of the new keywords in the released R14 User’s Manual are also 
supported.  

LS-DYNA R11.0 is the default keyword output format from PRIMER. (However, output may be 
generated for later releases of LS-DYNA.) 

 

1.2 Hardware platforms supported 

The complete Oasys Ltd LS-DYNA Environment 20.0 is available on the following platforms: 

Windows  Windows 10/11 64 bit 

Linux RedHat Enterprise 7.x, RedHat Enterprise 8.x 64 bit 

The RedHat Enterprise 7.x/8.x builds have been released on the website for Linux as this has 
been found to run on all the machines we have tested (RHEL 7, RHEL 8, SuSE 12.4). 

If you require a different Linux build, please contact Oasys Ltd. 

For Oasys V21, currently planned for spring 2024, will only be available on RHEL 8. This is 
because RedHat Enterprise 7 Linux will reach “End of life” on June 30th 2024. We would 
encourage all users currently running RHEL 7 to migrate to RHEL 8 during the life of the V20 
release but we appreciate that this may present problems on legacy systems. If withdrawal of 
support for RHEL 7 will create problems for you, please contact us as soon as possible so that 
we can discuss possible solutions. 

 

1.3 Graphics hardware supported 

The default graphics protocol used on all platforms in the table above is OpenGL, which gives 
good quality 3D performance on a wide range of hardware. 

‘Legacy’ X-Windows (2D only) graphics drivers remain in PRIMER on Linux platforms only, 
since these are used by a small minority of clients who display over a network of mixed machine 
types. However, this X driver is not maintained or updated and will give poor performance, so it 
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should only be used as a last resort.  There are much better ‘thin wire’ graphics solutions 
available today, and Oasys Ltd can give advice about these on request. 

 

1.4 Licensing 

This latest version of the software will only use the LM-X licensing platform to provide an 
increased level of license security.  

To ensure you’re ready to enjoy all the great features Oasys Suite 20.0 will bring, we recommend 
you update all your Oasys Suite license servers and files as soon as possible.  

Action to take  

If you’re using a floating network license you will need to install the LM-X license server 
software (version 5.2). The software and supporting documentation are available to download 
from our website and are also included in our installation packages. If you updated to 5.2 with 
the Oasys 19.X release, you do not need to update for the Oasys 20.0 release. 

Backwards compatibility  

The Oasys Suite 20.0 LM-X license file and license daemons are backwards compatible for all 
currently supported versions of Oasys Suite. This means that any existing 19.x, 18.x and 17.x 
software will continue to work with new LM-X license files and servers. 
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2 Bugs Fixed 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

2.1 PRIMER 

Adhesive 

• Case 50511 

The ability to select shells across multiple models under the ‘Adh.Patch Info’ tool on the 

connection table has been restored. This was accidentally removed when the front end was 

modified to include adhesive creation directly from solids. 

• Case 49739 

Two graphics problems were reported for patch adhesive connections. When these were remade 

from table, the solids did not always display properly. When selecting patch from the object 

menu, a mess of sketch lines could appear. Both issues are fixed. 

Belts 

• Case 50816 

Automatic beam creation for belt stiffness on seatbelt does not work when consecutive base 

point has beam PID defined. 

Fixed the problem. It should now create beam elements for consecutive base path points. 

• Case 48896 

Belt fitter was not remembering red drag handle only twist (from the ‘Advanced’ path definition 

settings) at points on model re-read which is now fixed. 

• Case 48361 

When (re)fitting a seatbelt using the command line ‘Fit’ command or the JavaScript ‘Fit’ method 

the thickness of a shell / 2D seatbelt belt as meshed was not set to the belt thickness defined in 

the fitting process, instead using whatever thickness the prototype element definition currently 

has set on its *SECTION card. 

 

The same problem occurs in the interactive (re)fit case, although it was less likely to be a 

problem since the interactive meshing operation requires the user to define a prototype element, 

section and material for each type of element used in the belt. 

 

This is now fixed as follows: 

 

- In the interactive (re)fit case the thickness of any prototype shell or 2D belt element 

*SECTION card is compared with the thickness used for fitting and if there is a difference the 

user is warned and forced to decide which value to use. 
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- In the batch, command-line and JavaScript cases the same check is made but if a difference is 

made the relevant *SECTION card(s) are updated to use the as-fitted belt thickness. 

• Case 47211 

Fixed the issue of a seatbelt material error message not being displayed from the scalar editor. 

• Case 45744 

When a seatbelt is fitted in PRIMER it ‘remembers’ the prototype properties used to mesh the 

belt on the *PART card in the form of template *ELEMENT_SEATBELT and/or 

*ELEMENT_SHELL definitions so that a subsequent refit operation can reuse these. However if 

a belt was originally meshed using 2D belt elements and then it is refitted and remeshed using 

shells the old 2D belt *PART, *SECTION_SHELL and *MAT_SEATBELT definitions are 

remembered even if they are not being used. 

 

PRIMER’s Cleanup Unused function would not remove these definitions since they are referred 

to on the *BELT cards, even though they are not currently being used. 

 

This is not a bug in the literal sense since the *PART card is referred to. However, LS-DYNA 

checks *SECTION_SHELL cards used with *MAT_SEATBELT and if these section definitions 

have no EDGSET (the node set used to specify 2D belt topology) then it exits with an error, even 

if there are no 2D belt elements using that section. 

 

Therefore, Cleanup Unused now has some special exception logic which inspects *BELT 

definitions for unused 2D seatbelt element prototype definitions and if these are not being used 

they no longer prevent the associated *PART definitions from being deleted. This in turn no 
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longer blocks the relevant *SECTION and *MAT cards, allowing these to be deleted as well (so 

long as they are not used elsewhere). 

Checking 

• Case 50813 

When VXVYVZ method is used to define orientation of a beam, PRIMER could issue spurious 

warning/error messages. Even though the LS-DYNA keyword manual comment suggested that 

V is a point relative to N1, V is actually a vector. Issue has been fixed. 

• Case 50721 

If the check panel is invoked with no models in memory the model selector button is now no 

longer greyed, so that a model subsequently keyed in can be loaded. 

• Case 49959 

Use of LOAD_BODY_PARTS with SET_PART_ADD was giving rise to spurious error 

messages because this set type was not being processed correctly. Now fixed. 

• Case 49798 

When a table contained a curve with ill-conditioned x data, the check that compares curves could 

get stuck in a loop. The table check is now only performed if all curves are defined with 

monotonically increasing x data. 

• Case 49746 

LS-DYNA will not initialize if there is a *MAT_ADD_THERMAL_EXPANSION keyword that 

refers to a part with MAT_172. We have added a check to detect it during Model → Check. 

• Case 49740 

The check category dropdown did not display properly if created with model with V3 keywords, 

when displayed subsequently for models with no V3 keywords. Now fixed. 

• Case 49325 

When the LS-DYNA Output Reader was reading the error message ‘Material types 173 and 198 

with NPLANES>0 should not be used with element formulation 2’ it was showing it differently 

in the tree view. Now fixed. 

• Case 49071 

PRIMER now does not crash if an incorrect filename is entered in LS-DYNA check directory 

textbox. It throws a warning message instead. 

• Case 48821 

Model modified did not always detect changes in *INTERFACE correctly. 

The logic that handles a mixture of labelled/unlabelled type has been improved. 
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• Case 48269 

Added an error if INITIAL_VELOCITY_GEN PHASE=1 but the 

*INITIAL_VELOCITY_GENERATION_START_TIME card is missing. 

Added an error if *INITIAL_VELOCITY_GENERATION_START_TIME STIME is out-of-

range of the analysis termination time. 

• Case 47360 

Autofix in high order solids was getting confused with interpolation nodes that are either in the 

wrong order, or simply slightly moved from their theoretical location. This has now been 

improved and it deals with both cases. 

• Case 46065 

When a user wants to call a DEFINE_FUNCTION entity creation panel from another keyword 

panel, the PRIMER user could change the keyword type to other related *DEFINE keywords. 

This is fixed now, and the PRIMER restricts the ‘Curve Type’ popup menu in this case to only 

DEFINE_FUNCTION_XXXX types. 

Comments 

• Case 47192 

Keyword headers were being written out even if there are no remaining entries to be written for 

the keywords concerned. Fixed it. 

Composites 

• Case 48752 

Changed the thickness hierarchy when contour plotting shell thicknesses to comply with the LS-

DYNA manual comment section for *PART_COMPOSITE (The element thicknesses defined 

via the *ELEMENT_SHELL_THICKNESS card now override those defined in the 

*PART_COMPOSITE card) 

Connections 

• Case 50536 

A new connection check has been added for case where nodes on different layers of clinch welds 

connect to the same segment. In PRIMER 19.0, if all nodes are tied in contact, they would 
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incorrectly be reported as REALIZED connections. Now they will be INVALID with clinch 

weld error. 

• Case 49777 

If line welds failed to make, no warning message was given. Now fixed. 

• Case 49685 

Multi-solid welds were not being created with correct area pi*d*d/4 where d is the specified 

diameter. This issue has now been fixed. Note that single hex welds had the correct value. 

• Case 48778 

After reading spotweld file (not xml), subsequent incarnations of connection create panel were 

missing the top buttons. Now fixed. 

• Case 46886 

The setting to allow MIG welds on feature lines was previously hidden in a preference. This is 

now available on the create panel. 

Contacts 

• Case 49605 

For *CONTACT... _MPP, the isometric PARMAX when set to zero should resolve to 1.035. 

Due to an error in a condition, this was remaining at zero and could cause failure of tied contact 

between curved surfaces. Now fixed. 

• Case 49601 

Tiebreak contacts between solid bodies may generate no ‘penetrations’ as the segments have 

zero thickness. However, the nodes should be tied if the offset is below tolerance. Issue now 

fixed. 

• Case 38632 

Calculation of whether an element is within box of *SET_SOLID_GENERAL, 

*SET_SHELL_GENERAL or *SET_SEGMENT_GENERAL has been considerably speeded up 

by use of threading and where appropriate, use of pre-emptive bucket setup. 

Control 

• Case 50146 

PRIMER will no longer crash when TSSFAC value is updated in CONTROL_TIMESTEP. 
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Crash test setup 

• Case 50525 

In the Batch Crash Test Setup script, running a RCAR Low-Speed (Front) load case with a user 

defined contact offset distance led to a script crash. This is now resolved and RCAR Low-Speed 

(Front) cases can be run with a user defined contact offset distance. 

• Case 50442 

Updated the FMVSS 214D Side Impact load case example image. 

• Case 50441 

Updated the default EuroNCAP Side Impact Mobile Deformable Barrier velocity to 60 km/h. 

• Case 50439 

EuroNCAP Frontal Impact MPDB changes:  

- Updated the example Image, default barrier offset and barrier ground height.  

- Added barrier speed. 

• Case 49575 

The Batch Crash Test Setup script will now write the <default> vehicle and barrier settings to the 

batch XML file as ‘default’ instead of ‘<default>’. This will allow the script to import the 

settings and apply the default settings again without crashing. 

• Case 48687 

In the UI Batch script, a crash occurred if the user selected <default> vehicle and barrier settings 

after reading in an XML file, this has been fixed. 

Curves 

• Case 48824 

When using the ‘Zoom’ option and dragging the cursor to define the area to zoom into, some of 

the red squares do not get undrawn. This does not happen if the area is defined by selecting two 

points or dragging the cursor at a very low speed. 
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This has been fixed now. 

Cut Section 

• Case 49849 

In PRIMER, the Plane Display option on cut section only displayed one cut direction when set to 

Wireframe or Transparent. Now, it displays all cut directions similarly to D3PLOT. 

D3PLOT→PRIMER link 

• Case 49648 

The QP mass props drop-down uses the PRIMER mass property toll over the link. For each mass 

calculation the process must be closed in PRIMER. Making a second pick in D3PLOT without 

doing this will fail to re-calculate. In case this is not obvious to the user, a prominent warning 

message is now issued in PRIMER. 

Damping 

• Case 42531 

Corrected the menu name for two keywords editors. Changed GLOBAL_DAMPING to 

DAMPING_GLOBAL and MODAL_DAMPING to DAMPING_GLOBAL. Also added box 

alias for these two editors so that old macros still work. 

Deleting 

• Case 48263 

In the Cleanup Model menu, if a user only wants to delete some objects of a given type rather 

than all the ones listed, it is possible to toggle on/off individual objects. When an object type has 

some items selected for deletion and others not, the Delete button would be drawn in the wrong 

colour and, if the state was changed again such that all objects of that type are now selected for 

deletion or to be left in the model, some artifacts of the button would seem to remain when the 

colour updated. This has now been fixed so that the button is drawn in the intended colours (blue 
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grey in the Light and Dark themes; pale green in the Classic theme) and the artifacts are properly 

cleared when the button colour changes. 

Dummies 

• Case 50111 

PRIMER was not able to determine the cable attachment nodes for the THUMS and GHBMC 

models while rigidifying the dummy tree assemblies for these HBMs. This has been fixed by 

retrieving the nodes mentioned in dummy tree files. 

• Case 50004 

When a THUMS HBM is positioned with the ‘Dummy and Seatsquash’ tool, the units for the 

time duration for simulation/settling were coming out wrong. Fixed this. 

• Case 48529 

When a user pressed the Rigidification (‘R’) button on the Dummies/HBM positioning tools 

panel, PRIMER used to take a bit of time to perform the rigidification process. This is now fixed, 

and PRIMER does the rigidification of the dummy assembly quite quickly. 

Edit 

• Case 48899 

Following updates were done to the *SECTION_SHELL edit panel: 

1. Corrected the position of ELFORM cards to remove the gap that occurred between mandatory 

shell cards and optional ELFORM cards. 

2. Corrected the card numbers, to be consistent with the keyword manual. 

Elements 

• Case 49541 

The filename text box for DIRECT_MATRIX_INPUT was un-necessarily truncated on the edit 

panel. Now fixed. 

• Case 49404 

The read of RBE2s in a NASTRAN model could cause the appearance of spurious latent nodes 

at very high labels due to an over-run while reading the nodal data array for RBE2s. Now fixed. 

• Case 48316 

Previously, all nodes were simply mirrored when reflecting solids with high order interpolation 

nodes. This resulted in a wrong order of those nodes, which was producing LS-DYNA errors. 
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Now, the nodes are re-ordered after reflecting so they remain as indicated in the LS-DYNA 

manual. 

Encryption 

• Case 50190 

Partial encryption of define tables are now supported in the encryption tool. 

• Case 49975 

The encryption tool now keeps the order in which load curves appear in files and the select 

associated button now grabs all the load curves associated with a table. 

• Case 49737 

The encryption tool now correctly stores the order of the table and load curves. 

• Case 48645 

Added checks for cross-referenced load curves. 

Explode 

• Case 50618 

After using the ‘Conx between includes’ option in the Tools → Explode menu, hovering the 

mouse over the model could sketch parts that were blanked. This has been fixed. 

FMH 

• Case 50696 

For the Tools → Safety → FMH → FMH manual setup → Current head position → Create/ Edit 

panel, the ‘Max HIC’ button has been widened to prevent text truncation. 

Graphics 

• Case 50959 

When creating a new *INITIAL_VELOCITY_NODE the visibility of this type should be turned 

on automatically (if not already on) so that the newly created item becomes visible. This didn't 

happen, instead it turned on the visibility of *INITIAL_FIELD_NODE. It will also affect a few 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 20.0 
 

Ove Arup and Partners Limited | Final | March 2023  

 

Page 12 
 

other *INITIAL keywords as well and possibly some *BOUNDARY, *CONSTRAINED and 

*LOAD too. Now fixed. 

• Case 50128 

When the user hovers over the first auto button in the keyword panel of the CONTACT 

keyword, the popup list does not flash constantly anymore. 

• Case 49477 

The graphics of translational joints was wrong if the nodes N5 and N6 were not orthogonally 

‘opposite’ nodes N1 and N2, resulting in the symbol being skewed. (This did not affect its 

correctness as a keyword in the model.) 
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Corrected by treating N5 as defining the plane N1N3N5 and N6 the plane N2N4N6 and drawing 

the ‘square section’ of the joint accordingly. 

• Case 48715 

Odd bits of text were getting appended to Date in the graphics window when the Model had a 

long title. This has now been corrected. 

• Case 48406 

Beam true section display now considers _THICKNESS option if it is used with 

*ELEMENT_BEAM and override the properties on *SECTION_BEAM for ELFORM 1, 4, 5, 7, 

8 and 9. 

• Case 47739 

Removed the need to press CT/SI while switching between child contour options. 

• Case 47738 

If plot is switched back to shaded plot after velocity vectors are plotted in nodal plot (over a 

shaded plot) with velocity vectors drawn in entities, the plot does not show the vectors. Fixed the 

issue with plotting initial velocity through the entity panel after a nodal plot. 

IGA 

• Case 48526 

PRIMER previously calculated the mass of parts with multiple associated 

*ELEMENT_SHELL_NURBS_PATCH keywords incorrectly. Now, PRIMER outputs the 

correct masses when running mass calculations in this context. 

• Case 47748 

Blanking of IGA_SHELL type part via quick pick screen area (aka. when user drags rectangle on 

screen) did not work properly previously. Fixed issue with screen area blanking from quick pick 

for IGA_SHELL type part. Also added IGA_SHELL type filter in Part in quick pick. 

Image 

• Case 50243 

Mesh Volume Analysis Tool help image now resized to fit the window. 

• Case 50237 

When the normal background colour of the graphics window is not white, it is possible to select 

‘use white background’ when images are captured, which temporarily changes the colour of 

overlay and text to give contrast against the white background. 

 

This was not working for the contour bar on SI, CT and Vector plots which retained their 

original colour, and since this was typically white for text it resulted in the text becoming 

unreadable. 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 20.0 
 

Ove Arup and Partners Limited | Final | March 2023  

 

Page 14 
 

 

Now fixed by swapping these colours temporarily. 

Include 

• Case 47524 

Problems can arise when a ‘once only’ card such as *CONTROL or *LOAD_GLOBAL is 

defined in multiple files and these files are subject to transformations which modify the contents 

of the card in question. PRIMER’s ‘clone’ logic used in this situation assumes a single true 

definition that can be referred to from multiple places, but if each reference is different in detail 

this assumption fails. 

 

The only full solution to this problem is to permit multiple different definitions of ‘once only’ 

cards to co-exist inside PRIMER, but such duplication is really a modelling error and would 

introduce all sorts of problems. For example, model checking would become ambiguous if 

different versions of key control cards had different settings, which would be the ‘true’ one? 

 

So the ‘clone’ logic is retained but the include file of residence of such definitions is now more 

tightly controlled: 

 

- If a ‘once only’ card occurs in an include that is read both untransformed (by *INCLUDE etc.) 

and transformed (by *INCLUDE_TRANSFORM etc.) then the untransformed location will be 

used as the ‘true’ location regardless of what the users chooses when presented with this error 

during keyin. 

 

- If the include file above is only ever read transformed then by default the ‘true’ definition will 

be placed in the last such file. 

 

This logic is driven by changes that have been made to keyout. Previously each include file was 

written out in order of occurrence, with transformed files being untransformed first. This meant 

that an include file used multiple times would be written multiple times, moreover that the slight 

numerical precision errors introduced during ‘transform when reading’ and ‘untransform when 

writing’ would be those of the last file written to disk. 

 

This logic remains with the exception that if an include file is read as both untransformed and 

transformed then during keyout only the untransformed version will actually be written. Not only 

does this speed up keyout by omitting duplicate write operations but it also removes the small 

precision errors introduced by transform/untransform operations. This also explains why the 

include file of residence for the ‘true’ definition of duplicated cards is the untransformed file. 

 

If good modelling practice is followed the problem should never arise. However, it did occur 

with a real model, hence the changes made above. 

Initial 

• Case 48690 

When sketching all *INITIAL_PWP_NODAL_DATA (pore water pressure) cards, PRIMER 

would appear to freeze while drawing things (consuming, and possibly exhausting all the 
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memory on the system). 

 

The reason was that these cards can refer to a part, yet are defined at nodes, so many nodes will 

refer to the same part. This meant that when sketching definitions at many nodes the same part 

was being redrawn repeatedly, taking a long time and consuming memory. 

 

There is now a test during sketching operations (of anything, not just PWP cards) for attempts to 

redraw ‘expensive to draw’ things such as parts and sets repeatedly, and they are no longer 

drawn more than once. Therefore, drawing all PWP in a model with ~100,000 such definitions is 

now nearly instant. 

JavaScript API 

• Case 49922 

A script that imported a module and used a GUI Builder file would not run if another script was 

also running. This is now fixed. 

• Case 49827 

If a JavaScript ES6 module that was imported had an error in it, PRIMER would not give details 

on the error when the script was run. However, if the script was run in the debugger, PRIMER 

would correctly show the error. PRIMER now correctly shows the error in all cases. 

• Case 49800 

In some cases, the interrupt button did not work in the JavaScript debugger. This has now been 

fixed. 

• Case 49789 

History.Create() opened the wrong DATABASE_HISTORY editor. 

 

For example, History.Create(m, History.NODE) opened a DATABASE_HISTORY_BEAM edit 

panel. This has been fixed. 

• Case 49778 

PRIMER was crashing when calling the JavaScript function GetInitialVelocities() on a node 

without initial velocities (without the nvels field populated). Now fixed. 

• Case 49598 

In the GUI Builder, sliders were being drawn with a ‘+’ and ‘-’ when the ‘arrows’ property was 

set to false. It now no longer draws them. 

• Case 49590 

Colour of individual NRBs and Joints can also be set from their respective JavaScript API 

classes. 
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This has now been extended to Airbag, Contact, CrossSection, ExtraNodes, NodeSet, 

RigidBodies and Spotweld classes. 

• Case 49589 

NRB colour can now be set from JavaScript with Options.nrb_colour 

• Case 49563 

Previously, PRIMER allowed the input of Infinite values through JavaScript. It is now updated 

to give an error if any Infinite values are encountered in the JavaScript. 

• Case 49557 

A GUI built from the GUI Builder was setting the macroTag of a widget to a blank string if 

nothing had been set for that property, which was not very useful when recording a macro. 

 

If the macroTag has not been set, it is now ignored. 

• Case 49134 

The Fit() method will now work as intended. It will now consider new points (if any) during the 

fitting process using the JavaScript API. 

• Case 48653 

Fixed a PRIMER crash when the JavaScript API member function ImportInclude(incl) had a 

parameter incl which is a model without include files. This parameter had been previously 

returned by the function Include.GetFromID(m, 0) if model m did not have include files. 

• Case 48041 

Added MATEN to JavaScript API for *CONTROL_ENERGY 

• Case 44031 

When selecting text in a text button by dragging the mouse over the wanted characters, it could 

prove impossible to select the first character of the string if the text was left-justified in the box 

with no leading white space. This problem was more commonly encountered in JavaScript 

panels. This has nothing to do with JavaScript itself but rather because left-justified buttons were 

more commonly used in JavaScript panel textboxes. 
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Fixed by correcting the drag logic which could omit the 1st character of a string in some 

situations. 

Keyword 

• Case 50844 

There was a typo in the heading of the <PROJ> popup in the *CONTROL_SHELL editor. This 

has now been corrected. 

• Case 50194 

The _TITLE suffix has now been added to the *SENSOR_CONTROL keyword. 

• Case 50011 

Fixed 2 bugs related to the *FREQUENCY_DOMAIN_SSD keyword: 

1) FREQ_SSD Create/ Modify panel error: PRIMER enters infinite loop if users follow the 

following steps: 

1. Create/ open a model 

2. Keyword → FREQ → SSD → Create 

3. Select any non-SUBCASE option 

4. Add a load card 

5. Switch to SUBCASE option 

2) FREQ_SSD field <SF> is a float in the manual but is currently an integer in PRIMER. (Fixed 

by making <SF> a float in PRIMER.) 

• Case 49999 

When other fields were set equal to <excl> in MAT_ADD_EROSION, the units change will 

now not operate and change these values. 

• Case 49791 

In the *ICFD_INIT_NONE keyword editor, there is now a radio option to select ICFD_PART or 

ICFD_PART_VOL for the <PID> type. 

• Case 49714 

There is a preference ‘mat_173_r14_read’ which can be set to false if user wants to read LS-

DYNA R13.0 keyword instead of LS-DYNA R14.0 
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Added support to read LS-DYNA R13.0 ‘BATTERY_ECHEM_CONTROL_SOLVER’ 

• Case 49454 

ICFD_PART and ICFD_PART_VOL are now treated as separate keywords and have their own 

edit panels. 

• Case 48380 

For *CONTROL_TIMESTEP, card 2 was not written out when only field <emscl> was present 

on card 2. Now fixed. 

• Case 47444 

PRIMER read in and keyed out *BOUNDARY_PRESCRIBED_MOTION_SET_LINE 

incorrectly previously by reading in and keying out card 4 before card 3. 

This has been fixed and it now reads in and keys out card 4 after card 3. 

Keyword Editor 

• Case 50388 

The *CONSTRAINED_SOIL_PILE and *CONSTRAINED_SOIL_PILE_CURVES Create 

panels previously greyed out their Create, Text Edit and Sketch buttons whenever the Check 

button was clicked. This has now been fixed. 

• Case 49514 

SENSOR_DEFINE_NODE_SET: NODE1 was previously always a node. However, it should be 

a node set except when NODE1 is negative and SETOPT is not defined. Now fixed. 

• Case 48293 

Corrected a typo on a keyword editor panel. ‘DAMPING_FREQUENCY’ is now replaced by the 

correct ‘DAMPING_FREQUENCY_RANGE’ for the *DAMPING_FREQUENCY_RANGE 

keyword editor. 

MPP 

• Case 50268 

Removed additional end slash so LS-DYNA run can happen properly. 

Macro 

• Case 48214 

If a macro that interacted with some tick boxes (such as those on the Edit Favourite 

Tools/Keywords panel) was recorded, it would not correctly tick/untick them when it was played 

back. This has been corrected. 
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Manual 

• Case 45952 

The LS-DYNA Keyword manual can now be opened on the correct page using the Keyword 

manual link (K) when Firefox, Chrome or Edge is used as PDF reader. 

Mass 

• Case 49172 

Models with INITIAL_PWP_NODAL_DATA could report incorrect mass when an individual 

part is selected due to an error in propagation of the selection. Now fixed. 

Materials 

• Case 49786 

Previously, the Material keyword editor would present the incorrect keyword structure for 

*MAT_OGDEN_RUBBER for instances that had values of PR < 0 and N > 0, or if N < -1. This 

has now been fixed. 

Measure 

• Case 49795 

The Die closure option for measure Part to Part did not always work properly. This has been 

modified to use parametric of projected point on segment rather than angle check. If parametric 

exceeds +/-1.0 the measure is ignored. 

• Case 48381 

1) Added text background to measurement screen values displayed so that values are more 

visible and will no longer get blocked by lines. 

2) Added ‘Measurement Text Background Transparent’ option to measure tools 

- Default: Text background drawn (like in D3PLOT), see (1) above 

- Option selected: No text background (original PRIMER behaviour) 

- The corresponding preference has also been added: measure_text_bg_transparent 

3) Added measurement screen values to the ‘Node angle’, ‘Point to Point’ and ‘Point angle’ 

measure modes 

• Case 48239 

Fixed a bug in the Measure tool in which geometry points do not get properly processed in the 

‘Node to Part’ and ‘Node to Plane’ modes (if a geometry point is selected in the ‘Node to Part’ 
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mode, it gets confused for a Node and the distance does not get computed in ‘Node to Plane’ if a 

geometry point is included in the list). 

Menus 

• Case 50227 

Fixed the UI issue where the ‘_INTERIOR’ button obscures the Drag wall directions in the 

DATABASE_CROSS_SECTION panel. 

• Case 49597 

When a floating window inside any of our applications’ master window is moved upwards so 

that its top bar, which you must click on to drag it, is within the Window manager’s outer 

decoration this would result on its top bar being obscured. This would make it impossible to drag 

thereafter. 

 

Fixed by detecting this ‘move into top decoration window’ situation and ‘snapping’ the window 

down when the mouse button is released so that its top border abuts the bottom of the window 

manager’s decoration. This means that its top bar remains visible and that it can continue to be 

dragged to a new position if needed. 

• Case 49328 

Closing the Read DYNA docked panel was opening the model panel in Contents mode instead of 

List mode. Now fixed. 

Mesh 

• Case 49622 

In mesh extrude with direction option set to N1 → N2, node selection was getting reset if user 

have changed from distance to |N2-N1|. It is fixed now. 

• Case 48554 

Earlier thickness of thick shell was getting lost after mesh reconstruct using Area → Remesh. It 

has been fixed now. Now shell thickness is remapped after remesh. 

• Case 47919 

Constrained NRBs, Initial load, masses etc. were not preserved during spotweld remesh. It is 

now fixed. Now, all the node cross references within the remesh diameter from spotweld which 

gets affected during spotweld remesh are restored post spotweld remesh. 

• Case 39377 

Added a checkbox ‘Make 3rd nodes unique’. This checkbox would be greyed out and checked if 

NREFUP=1. If NREFUP=0 it will not be greyed out and unchecked (by default), but the user 
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can choose to make the nodes unique or not. Use of this is that it will remind the user to set 

NREFUP if required. Feedback is given if it is already set. 

Metal forming 

• Case 48646 

When mapping stress and strain data from source to target using the Metal-Forming tool in 

PRIMER, the orientation of shells is now taken into consideration as follows: If the angle 

between the normal vectors of matched shells is above 90° (meaning the orientation between the 

source and target shell is very different), then the sign of the parametric position (field ‘t’) for 

each integration point in the *INITIAL_STRESS_SHELL and *INITIAL_STRAIN_SHELL 

cards is inverted before the data is mapped to target. 

Model build 

• Case 50653 

Status of the toggle buttons for build options were not setting properly. It is fixed now. 

Morphing 

• Case 48241 

Previously, morph boxes were unable to ‘find’ SPR rivets and so any rivets that were connected 

to some mesh being morphed would not get morphed with the mesh. This has now been fixed. 

• Case 44335 

Previously, when deselecting individual morph points after selecting them via a face/edge drag 

handle the deselected morph points would remain highlighted as if they were still selected, even 

though they were not. This has now been fixed such that the deselected morph points are no-

longer highlighted. 

• Case 42601 

Previously, if a HAZ weld was created in a morph box that already existed, the box would be 

unable to ‘find’ the HAZ weld and hence subsequent morphing operations would not move the 

connection entity or the new mesh that resulted from the weld creation. 

 

This has now been fixed as morph boxes now ‘find’ HAZ welds at the time of creation/remesh, 

as well as adding any new nodes from the remesh to those relevant morph boxes. 

• Case 42598 

Previously, PRIMER would automatically find connections and update their morphing 

information at the start of a morphing operation whenever PRIMER deemed that connections 

may have been altered. The logic for determining if a connection had been altered was quite 

conservative so this search/update of connection information could happen unnecessarily. This 

logic has been updated to more accurately determine when a new search/update is required. 
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It is also now possible to turn off the automatic search/update via an option in the Program 

options panel, or via the new preference primer*morph_find_new_connections_automatically. If 

turned off, a search/update can be triggered for all morph boxes by clicking (Find new 

connections) ‘All Boxes’, or for a selection of morph boxes by clicking ‘Sel Boxes’. These 

buttons will only become active when a connection has been created or altered outside of the 

morphing panel. 

• Case 40919 

Previously, if a HAZ weld was morphed by a morph box and then remeshed, but then the model 

was written out before performing another morphing operation, PRIMER would not add the new 

nodes from the remesh to the morph box. As a result, after reading the model back in, any 

subsequent morphing operations on that morph box would not affect the connection entity or the 

new mesh, leaving ‘wells’ in the morphed mesh. 

 

This has now been fixed as PRIMER now adds the new mesh to relevant morph boxes at the 

time of remesh. 

Orient 

• Case 49840 

Contact orient will use CONTACT_AUTOMATIC_GENERAL if beams are included in the 

contact. Analysis of contact has recently been corrected to reduce contact thickness for small 

shells (as DYNA). However, in this context, the physical shell thickness should be used so that 

the final position is properly depenetrated. 

Output 

• Case 50208 

For all SET keywords, spaces were always written for the <solver> field previously. Now, 

spaces would be left for the <solver> field only when we are writing out the <its> field and the 

<solver> field does not have a value.  

PDF 

• Case 47825 

The default names for PDF and postscript files have been changed to primer001. Also, the 

custom names get incremented properly now. 

Parameter 

• Case 50405 

PRIMER wrongly reordered include files in a deck containing parameters which were used in 

*INCLUDE_TRANSFORM statements. 

 

It checked that include files containing parameters used by such statements must be written out 

before them, but it failed to consider that if those referred-to include files were written out ‘early’ 
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then any other include files referred to by expressions within them must also be written out 

‘early’. 

 

This also had the effect of making the sequence order checks in the parameter editing panel 

report spurious order errors when none existed, it also meant that the ‘auto reorder’ function 

there failed to work because it was getting things wrong. 

 

Now fixed. The test for writing out include files ‘early’ remains because it is correct, but 

PRIMER now considers the knock-on effects of that in other include files so that they get written 

out ‘early’ as well if required. 

• Case 49729 

The Model.Check() JavaScript capability can generate JSON format files, and these contained 

format errors if *PARAMETERs contained errors. 

 

The problem was that parameters used to report their internal PRIMER label in error and other 

output, but this was not helpful since labels could change and it was impossible to relate label 

and parameter name, so parameters now report their names in these contexts. However, in JSON 

files a character string must be enclosed by quotes and the coding which output an unquoted 

numeric label had not been modified. 

 

Fixed by inspecting the label prior to JSON output and quoting it if it contains anything other 

than the characters 0 - 9. 

• Case 49482 

Fixed some problems with the *PART_MOVE keyword: 

 

(1) If a parameter was used to define a data field on this card it would calculate correctly when 

first read, but if the parameter values was changed within the PRIMER session the position of 

the part would not update correctly. 

 

(2) If a local coordinate system was used for the movement vector PRIMER would show the part 

moving in the wrong direction, inverting the local coordinate system in this context. 

 

(3) If a Part Move card used a local coordinate system or vector and the card was edited inside 

PRIMER to remove this, treating the movement vector as global, the position of the moved part 

would not revert to the global system. 

 

These errors affected how the part was positioned visually in the PRIMER session, but because 

movement is ‘undone’ prior to keyword file output they would not have affected the ultimate 

analysis. 
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They are now all fixed. 

• Case 48880 

Opening the Parameter→ Modify panel was taking a long time when a parameter was used in 

many data fields. Now fixed. 

• Case 47543 

If a (scalar, not expression) *PARAMETER was itself defined by an implicit parameter using 

<xxx> syntax PRIMER would substitute the value of the parameter and ‘lose’ the <xxx> 

definition. 

 

This is now fixed as follows: 

 

− *PARAMETER defined by <xxx> syntax ‘remembers’ this, using the value of the <xxx> 
expression in numerical contexts but preserving the <xxx> syntax. 

− - In the various editing panels for *PARAMETER this syntax is also preserved, or can be 
used when modifying and creating parameters. 

 

A scalar *PARAMETER defined by another explicit parameter using ‘&name’ (or plain ‘name’) 

syntax worked previously but required some internal compromises. In particular that syntax 

would not be used in parameter editing panels. This has been improved so that scalar parameters 

defined by ‘&name’ or plain ‘name’ now also use that nomenclature in editing panels and, as 

with implicit parameters, may be modified or created using that syntax. 

Part Replace 

• Case 47941 

Assembly replace may relabel items of source model to allow import. Issue fixed. The process 

now restores the original labels on completion. 

Pedestrian 

• Case 50645 

Previously, after using the ‘Only’ part selection buttons in the Pedestrian Markup tool on Linux, 

the part selection would not immediately appear in the graphics window - a redraw event was 

required to show the ‘Onlyd’ selection. This has now been fixed such that the ‘Onlyd’ selection 

appears automatically. 

 

Also, when writing out a .pmset file from the Pedestrian Markup tool, the WAD line distances 
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were not written out correctly, which could cause issues when reading the .pmset file if the 

WAD distances had were non-default values. This has also been fixed. 

• Case 50447 

The Pedestrian Markup tool in PRIMER offers users the ability to alter the angles of certain 

sticks/pads used to determine the markup lines for a given protocol. Previously, the tool was not 

honouring an alternative angle for the pad used to determine the corner bumper point during a 

CNCAP/GTR (UN R127) markup, and in fact could produce incorrect results for the corner 

point in these circumstances. This has now been fixed. 

• Case 50119 

Previously, if ‘Write elements to keyfiles’ was selected in the Pedestrian Markup tool, the nodes 

written to bonnet_rear_offset.key would have incorrect z-coordinates. This only occurred for the 

GTR / UN R127 protocol. This has now been fixed. 

• Case 49558 

Previously, the pedestrian markup tool could potentially crash after performing a markup if one 

of the bonnet rear reference line balls failed to contact the bonnet and windscreen at y=0. This 

has now been fixed. 

Penetrations 

• Case 49302 

On the contact penetration check panel, there are buttons ‘Pick & propagate’ and ‘Pick, 

propagate, fix’ to fix crossed edges. With these buttons, nodes can be picked from the screen, but 

there was no feedback when the mouse was hovered over nodes. Now, there is the same 

feedback as in other picking operations. 

Quick pick 

• Case 48871 

In the Quick Pick type menu, there is an ‘other’ category button which maps a sub-menu of less 

common types in the model. Previously, this showed a wide range of potential types, even when 

these did not actually exist in any model in the database, which did not make sense since you 

cannot pick something that is not there. 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 20.0 
 

Ove Arup and Partners Limited | Final | March 2023  

 

Page 26 
 

 

Changed this so the sub-menu now only consists of types present in the model(s). 

Read 

• Case 49398 

If the read option ‘skip & continue’ is set and a missing include is encountered on keyin, the 

STOP button did not stop the read. Now fixed. 

Renumber 

• Case 50250 

Lock Label panel was behaving oddly when attempting to resize, this has been fixed. 

  

Scripting 

• Case 50240 

The following issues have been fixed in the GUI Builder: 

 

1. Adding a new widget from the dropdown menu at the top of the window did not deselect any 

currently selected widgets. It now does. 

 

2. If you clicked in the textbox used to set a widget item name, did not change the name and 

pressed return, it would issue a warning message to say it was not unique. This has been fixed. 

 

3. Check boxes in GUIs written out as a raw JavaScript (.js) file with the theme set to 

THEME_DARK did not display the tick when they were selected. This has been fixed. 

 

4. After reloading a .jsi file combo boxes showed the first item, rather than the selected item. 

This has been fixed. 

• Case 49195 

In SBA tool, belt fit was going wrong if seat’s cushion was too thick. We have now increased the 

default distance to move lap block’s belt point in +Z axis to fix the issue. Now, we have added 
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an option to move lap block’s belt points in +Z axis to remove any initial belt penetration with 

the lap block and seat. 

Selection 

• Case 47772 

Previously, some picking operations in PRIMER that allowed selection by area (e.g., selection of 

drag handles in the mesh morphing panel) would only reject the last item selected, rather than the 

selection group, when clicking the middle-mouse button. This has now been fixed. 

• Case 47736 

Previously, for object picking operations in PRIMER, clicking the middle mouse-button could 

result in multiple selection groups being rejected, rather than just the most recent one, if some 

items from those selection groups were deselected via a right mouse-button click. This has now 

been fixed. 

Sensor 

• Case 50472 

Previously, PRIMER would throw a warning message about *SENSOR_CONTROL <ESTYP> 

being omitted when writing out in LS-DYNA R9.0 or earlier (LS-DYNA R8.0 or earlier if 

<TYPE> was set to ELESET), even when <ESTYP> was unpopulated (set to -NONE- in the 

PRIMER editor). This has now been fixed such that the warning is only thrown under those 

conditions when <ESTYP> is populated. 

• Case 48501 

ELESET on SENSOR_CONTROL was only being written out in LS-DYNA R10.0 previously. 

It will now be written out in LS-DYNA R9.0 as well. 

Sets 

• Case 49970 

LOAD_BODY PSID may contain NRBCs. If a part label is changed to match one of these, the 

NRBC will be replaced by part in the set which may give an error in the LOAD_BODY. This 

behaviour has been corrected for parts created by orient copy and parts relabelled on the edit 

panel. Using different labels for NRBCs and PIDs is highly recommended. 

Sketch 

• Case 50284 

If some entity is sketched from the top level [Keyword] Sketch menu, then hitting ‘Apply’ a 

second time could effectively ‘unsketch’ it. 

 

This was due to the implicit assumption that whatever is being sketched and ‘owning’ the 

crosshairs must be different to what is already being sketched. 
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Now fixed. If the selected item is already being fixed then no visual change occurs. 

Spotwelding 

• Case 49644 

When creating a weld, if a single spotweld part existed in model, PRIMER did not allow user to 

select another part with missing or encrypted material. PRIMER now only excludes parts from 

selection which cannot be welds. 

Transfer 

• Case 48999 

PRIMER was crashing when there was no model in Other → Transfer and Apply clicked. Now 

fixed. 

Transform 

• Case 45652 

On RIGIDWALLs the 8th significant figure of RADCYL and LENCYL fields could change 

during a transformation, even the transformation was null (i.e., no rotation, translation, scaling or 

reflection). 

 

This was a precision problem caused by creating a trial vector for wall local axes to perform 

scaling, doing nothing to it and then deconstructing it again to update these data fields. Creating 

the vector requires subtraction which is numerically sensitive and adds a small amount of noise. 

 

Fixed by checking to see if scaling is active and omitting the vector calculation if it is not. 

Units 

• Case 49715 

Fixed typos for units in PRIMER. Changes made: 

- Added spaces after commas (mm, kg, s) 

- Made capitalisation consistent 

- Reordered the units according to scale (Length: mm, cm, m, in, ft; Mass: g, kg, t, lb, slug; 

Time: μs, ms, s etc.) 

• Case 49633 

Usually, unit conversion for Load curves is done in PRIMER using scale factors. But for 

*DEFINE_CURVE_SMOOTH, no scale factors are present and hence no unit conversions are 

being applied. Issue is now fixed (see below). 

Updated *DEFINE_CURVE_SMOOTH such that whenever the unit conversions tool is used in 

PRIMER, the relevant unit conversion factors will be applied directly to the fields DIST, 

TSTART, TEND, TRISE and VMAX. 
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Relative modification was also done to *BOUNDARY_PRESCRIBED_MOTION, such that the 

field SF remains as 1 (SF=1) when the field LCID refers to *DEFINE_CURVE_SMOOTH. 

• Case 49562 

The units of energy release rate parameters (G1C_O, G1C_INF, G2C_0, G2C_INF, G3C_0, 

G3C_INF) in *MAT_240 keyword were corrected. 

User interface 

• Case 50589 

Renamed labels under SORT in Renumber Include panel. Made all the Sort options consistent by 

making them start as ‘Sort by...’. 

• Case 50257 

There occurred an issue of left over checkbox borders of ‘Save children’, ‘Retrieve children’ and 

‘Delete children’ checkboxes in the Save/Retrieve panel under the mechanism panel, when we 

switch between Save, Retrieve and Delete options. This is fixed now. 

• Case 50230 

If the Part Tree was undocked and then dragged onto the desktop then, on Windows only, 

redocking it would result in a subtle change in its behaviour. Anything which caused the overall 

PRIMER window to be redrawn, for example a size change or a change to the display of the 

tools or keyword panels, would result in the Part Tree window being shown at the top of the 

‘tabbed’ area even if some other window was explicitly chosen to be top most. 

 

This was due to an error in the internal (Windows) attributes of the Part Tree window when 

moved from the desktop back into the PRIMER window, causing it to appear to be ‘On top’. 

Now fixed. 

• Case 50223 

‘Target file’ textbox in IPP TARGETTING PANEL and ‘Output dir’ textbox in KEYOUT 

PANEL under the same IPP TARGETTING PANEL are now updated to be left justified 

(default), which were right justified before. 

• Case 49497 

In the GUI Builder, if you tried to set the ‘top’ property of a widget to a value greater than the 

‘bottom’ value, it refused to update the value. 

 

This has been changed so that in this case it now sets the top property to whatever value the user 

set it to (so long as it’s not outside the top window boundary) and modifies the bottom property 

so the height of the widget stays the same, with the caveat that if this would make the widget go 

outside the bottom window boundary it gets clamped to that. 

 

The same logic applies if you try and set the bottom property to be a value that’s less than the top 
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property, the left property is greater than the right property and the right property is less than the 

left property. 

• Case 49287 

The Volume Calculator Tool previously required the user to select the .csv and .xlsx write-out 

directories and filenames in two separate steps. This is now done in one step. 

• Case 47716 

The speed of scrolling through lists has been improved when using the new user interface. This 

is substantially faster when using a remote connection, also see case 48216 (Oasys enhancement 

case). 

• Case 44698 

When a graphics sub-window was dragged out of its master window (e.g., the PRIMER window) 

onto the desktop then clicking on one of buttons on the top such as ‘File’ to map a popup sub-

menu could result in that popup being invisible, making it look as if it did not do anything. In 

fact, the popup was mapped underneath (behind) the graphics window meaning that it was not 

visible. 

 

Caused by an internal error, now fixed. 

• Case 43904 

When text was highlighted in a text entry button then, with the button still selected, the mouse 

was moved out of the menu panel containing the button the text highlighting could be lost if the 

mouse was then moved back into the button. 

 

This was due to an internal error in the way motion of the mouse and its behaviour when 

crossing window borders was being processed in this context, now corrected. 

Volume 3 

• Case 43044 

Latent parts not distinguished on 'ICFD model setup' window. Now fixed by the following: 

-Added Latent colouring for Part text box when used latent Part numbers 

-Added Warning colouring for Part text box when used ‘0’ or ‘<null>’ 

Write 

• Case 49756 

Default write directory and overwrite for images not working.  

Fixed image overwrite logic. Default image directory now maps to the current directory for file 

browser when users drag & drop or use the recent file popup to read a file. 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 20.0 
 

Ove Arup and Partners Limited | Final | March 2023  

 

Page 31 
 

• Case 47950 

Fixed the issue of resetting file type for LS-DYNA files in write menu when user has selected a 

type before selecting the model number. 

X-sections 

• Case 48561 

‘Only visible’ option for *DATABASE_CROSS_SECTION has been fixed. The cross section 

scales itself accordingly to the elements that have not been blanked. 

ZTF 

• Case 49475 

LS-DYNA permits the _ID or _JOBID suffices on the *KEYWORD card to be used to create a 

prefix for the output results files that will be produced. 

 

When creating a ZTF file, PRIMER did not treat the _ID case correctly, resulting in a filename 

that might not match the other output filenames. Usually this did not matter because D3PLOT 

would pick it up anyway via ‘fuzzy filename matching’ but this has now been corrected. 

 

In addition, it turns out that LS-DYNA treats the _JOBID option as a verbatim string with the 

consequence that if it contains any embedded white space this causes the filenames to get 

misinterpreted. So, a check for this has been added to PRIMER with an Autofix option to replace 

embedded white space with underscore characters. 
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2.2 D3PLOT 

Airbag 

• Case 49925 

Fixed a crash that could occur when reading in a CPMFOR Interface file if a ZTF file was also 

read in. The crash would occur if the number of *CONTACT definitions in the model was 

greater than the number of CPMFOR surfaces. 

Animation 

• Case 47923 

On a Linux system that did not have 'core' X11 fonts loaded, the alternative bitmap fonts used 

when animating could be drawn in the wrong size and place. 

 

This has now been fixed. However, better results will be obtained if 75 dpi core fonts are loaded 

onto the system. 

Blanking 

• Case 39602 

Wildcards in the form of <m>*<n> are now supported in the top bar Quick Pick box in 

D3PLOT, where <m> and <n> are optional and could be any numeric values. Previously, only a 

standalone '*' wildcard was supported which would denote 'ALL' entities. 

Component 

• Case 50694 

Fixed a crash that could occur when opening a D3PLOT/PTF model followed by a FEMZIP 

model, closing both models, and then opening a new FEMZIP model. 

• Case 49895 

Fixed an issue where the PEMAG component would not read in for TSHELLs and would instead 

crash the program. 
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Contacts 

• Case 49842 

Fixed an issue that could cause the wrong contact surface to be displayed when intfor/CTF 

(contact interface force) files were read into D3PLOT and if the Part Tree was then used to 

blank/unblank contact surfaces. 

Contour 

• Case 50153 

When isolating the highest contour band in a CT or SI plot by clicking on the bar in the graphics 

window, sometimes elements with the highest data value were not included in the plot. This has 

now been fixed. 

• Case 49815 

With negative MAXINT on *DATABASE_EXTENT_BINARY, stresses for shells and thick 

shells are written by LS-DYNA for each in-plane integration point instead of layer-averaged 

values. For thick shells, D3PLOT only showed the first value as the value for the whole layer, 

whereas now it averages all across the layer for that case. 

• Case 48417 

Previously invalid values for Yield Utilisation Factor and Percentage were given a value of -1 

when they could not be calculated. Now they are given 'N/C' (not computed) which ensures that 

these invalid values do not affect the contour bar values when valid values are also shown. 

Cut section 

• Case 50822 

Cut section forces were not updated when the cut direction tab was changed. Now this happens 

correctly whenever forces are displayed. 

• Case 50652 

Autoscaling sometimes zoomed out too far when there were joints in the model and enough other 

entities were blanked. This has been fixed. 

• Case 49564 

When *DATABASE_CROSS_SECTION_PLANE is used, D3PLOT will render these planes as 

'thick slices' through the structure by calculating the intersection of the plane with its cut 

elements. 

 

This works correctly, but when a (D3PLOT native) cut section was created which was exactly 

co-planar with a cross-section plane, it could it previously could have resulted in strange looking 

overlay graphics where the plane cut 3D elements. 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 20.0 
 

Ove Arup and Partners Limited | Final | March 2023  

 

Page 34 
 

 

The problem has been solved. 

• Case 48879 

When a cut section was defined with actions Normal and Omit, then parts with one node exactly 

on the plane and all others on the omitted side could appear fully drawn. Now, for such parts, 

only the node(s) exactly on the plane appear, but the rest is correctly omitted. 

Data components 

• Case 50946 

If a model had Thermal Strain Tensor output turned on but didn't have Plastic Strain Tensor 

output turned on as well then the data plotted for thermal strains was wrong. This has been fixed. 

• Case 50048 

On the Cloud Plots tab in the Data menu the button text 'Point size options' overlapped with the 

radio button to switch between fixed size and size proportional to the magnitude. Now the 

buttons have been repositioned so that the text is readable. 

• Case 49588 

Fixed an issue with GLB export via the command line, in which the use of @ to specify 

integrations points while plotting data components on beams could produce incorrect results. 

• Case 49544 

Fixed crashes that could occur when plotting PMM_PRINC_MAX_&_MIN or 

S2MM_2D_PRINC_MM_STRESS in Direct mode for SPH elements. 

 

Also fixed an issue preventing criterion plots of PMM_PRINC_MAX_&_MIN and 

PALL_PRINC_ALL for DES from being enabled. 

• Case 51020 

D3PLOT output would mix up the top and middle layers when reporting initial temperature. This 

has been corrected. 

Deform 

• Case 50181 

Fixed a crash that could occur while screen picking inside windows containing multiple models. 

• Case 49200 

If the Shift Deformed option was used to remove a rigid body translation/rotation, the direction 

of any vector arrows was not updated to take into account any rotations applied to remove the 

rigid body rotation. Now fixed. 
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• Case 46672 

When entering a reference node either under 'Single node' or under '3 Nodes', it was applied to 

all models in which the node label existed even when a specific model had been selected. Now, 

the node label is only applied to the selected model when a model is specified. 

Dialogue command 

• Case 50304 

Dialogue commands for contouring with envelope plots did not work correctly when averaging 

was switched on. When the envelope plot is opened from the Data menu interactively, then 

averaging is automatically switched off. The same now happens when the envelope options are 

selected with dialogue commands. 

 

Also, the Data menu did not always update when the envelope options were changed with 

dialogue commands. This has also been fixed. 

Envelope 

• Case 49671 

If a Contact/Interface data component is being plotted then the option to switch on and off 

Envelope plotting is now available within the Data Menu. 

Errortrapping 

• Case 50318 

Removed an unnecessary error message saying 'No parent for slave window id' that could occur 

when applying a template that removed models from a window. 

Filename 

• Case 50714 

When reading additional files along with a model, the file filter for Groups files only showed 

binary .grp files by default. This has been corrected to filter for both ASCII .asc Groups files and 

binary .grp Groups files. 
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General 

• Case 50633 

If a model was displayed in multiple windows and the options to display free edges was set, then 

the full mesh overlay could still be displayed in windows showing SH, SI, CT plots if in another 

window, the same state was being displayed in a HI or LI plot. 

Now this is fixed so the mesh in the windows showing SH, SI and CT plots will not be drawn, 

showing only the free edges when Wire and Hidden Line plots are drawn in another window. 

Graphics 

• Case 50526 

Fixed an issue that could cause airbag particles to continue to be drawn at the current state when 

airbag particles display was switched off via the Entities menu. 

• Case 49674 

If a model with SPG Solid elements was displayed in D3PLOT then in a SI or SH plot the SPG 

elements could be drawn looking almost white if they were being drawn as spheres. The problem 

would only occur if the model contained other SOLID parts that were not SPG parts and the SPG 

part was not the 1st SOLID Part drawn. 

This is fixed so the spheres are now coloured correctly. 

• Case 49478 

Fixed the graphics of translational joints, which was incorrect if nodes N5 and N6 were not 

orthogonally 'opposite' nodes N1 and N2, resulting in the symbol being skewed. 

• Case 47835 

When using a 3D mouse, the centre of rotation of the model tends to shift dynamically. 

 

When the '0' shortcut key was used to export a view from a window in which the model had been 

positioned using a 3D mouse to other windows this change to the rotation centre was not 

exported. This meant that while the orientation of the model in the 'exported to' windows was 

correct its position on the screen might not be, and moreover subsequent rotations might take 

place about a subtly different centre coordinate. 

 

The centre of rotation on the screen is now exported in this situation, leading to more consistent 

results. 

Groups 

• Case 49485 

For binary group files that are automatically produced with the preference 

'd3plot*delete_group_file' set to TRUE, we appended a process ID to the file names from V19.1 

onwards. This was because we observed very slow processing when multiple D3PLOT instances 
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were accessing the same group file concurrently. 

 

However, there is a small but non-negligible chance that if those D3PLOT instances ran on 

different machines, they might have the same PID causing the issue to occur once again. To 

make this more unique, time information is now appended, resulting in a considerably more 

unique name, and making the chances of this happening again very unlikely. 

Help 

• Case 49529 

Updated the Blanking menu help text to make things clearer. The View/Hide and Ent(tity) help 

text now refer to the relevant panels and additional newer options such as 'M ==> M' propagate 

option are now included. 

Image 

• Case 49844 

Exporting from D3PLOT to D3PLOT Viewer format using dialog commands always exported 

window 1 regardless of the image window selection. This has been fixed. 

Integration 

• Case 46930 

When entities are sketched in PRIMER from the LS-DYNA output tree viewer, the sketching did 

not immediately happen in a linked D3PLOT session, but only after other operations forcing the 

graphics to refresh. Now it appears immediately in D3PLOT. Also, when the model was open in 

multiple windows in D3PLOT, the sketching from PRIMER would only have appeared in the 

first window after such a refresh, whereas now it appears in all windows in D3PLOT containing 

that model. 

JavaScript API 

• Case 49825 

The dialogue command /CM to set the current model changed the current window to the first 

window containing that model. If another current window is already set, this is now retained if 

this also contains the model specified with /CM. If it does not, then it uses the first window with 

the specified model as before. 

• Case 48971 

Bug fixes for the D3PLOT JavaScript API: 

- Fixed JavaScript bug 'DES is not defined' as the SharedConstants constant DES was previously 

not defined. 

- Added DataComponents constants LODE_PA, YUTF & YUTP to JS API manual. 
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• Case 48850 

If you use functions GetData or GetMultipleData to retrieve results for yield utilisation factor or 

yield utilisation percentage that are unable to be computed, an exception is now thrown instead 

of returning a large value (3.402E+38). 

• Case 48816 

The functions DialogueInput and DialogueInputNoEcho did not always work correctly for 

operations with multiple windows, for example when colours were set with dialogue commands 

from a script. This has now been fixed. 

• Case 48141 

In the JS API manual, the list of arguments of functions are not shown in a table any more. This 

will avoid cells of tables that get too big and do not fit in a page of the PDF version of the 

manual. 

Labels 

• Case 46117 

With the Quick Pick 'Dynamic Labelling' option in D3PLOT, it is possible to display the data 

value for an entity alongside its label. 

 

This option worked for node- and element-based data components, but if a PART based 

component was selected and plotted (Kinetic Energy) and a PART was selected for 'Dynamic 

Labelling', no data value was displayed. 

 

This has now been fixed. 

Materials 

• Case 47544 

In models with *PART_STACKED_ELEMENTS, new parts for the layers are created by LS-

DYNA during analysis. Previously, D3PLOT was not able to plot material properties for these 

parts. Now, the layer data is written to the .ztf file by PRIMER 20.0 and picked up by D3PLOT 

20.0 so that it can associate the layer parts with their materials and plot properties correctly. 

Measure 

• Case 50321 

When a Part-to-Part measure is defined and then a part is added to one side under the contour 

options, there is a selection menu. When there are no part sets in the model, the only object type 

to pick is PART..., but this row needed to be explicitly clicked. If a part was picked from the 

screen before clicking PART..., the buttons to add new parts were disabled. Now, parts can be 

picked immediately if there are no part sets present. 
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• Case 48109 

On the Measure panel there are new offset options (both on by default): 

- Deform: uses the transformed coordinates when there is a Deform option like Shift Deform 

switched on in the window containing the measurement. 

- Model space: takes into account the model space offset applied to a model in its window. If 

there is an offset in screen space defined, this will not be considered, since it changes with 

rotation of the view. 

Menus 

• Case 50764 

There was an error in the logic which highlights 'common edges' between windows which could 

cause a crash when the number of windows on a page increased from 16 to 17 or more. This was 

due to an internal storage error which, while generic, in practice only seemed to cause problems 

on RHEL 7 Linux platforms. 

 

The storage error has now been corrected and the problem fixed. 

Movies 

• Case 50951 

Movie capture could fail if: 

 - Two models had been read 

 - There was just one graphics window and both were in this window. 

The error message would say that there were no states to animate in the window. 

This was due to internal confusion about which model was being captured.  Now fixed. 

• Case 49560 

Fixed an issue that could cause the contour bar in exported movie files to show N/C values when 

contouring spotweld failure time (SPOTWELD_FTIME) on a model with a ZTF file while the 

option not to display unfailed spotwelds was selected. 

Output 

• Case 49029 

For sessions containing multiple models, some users prefer the default output directory for 

images and other output files to switch to the latest model read in, whilst other users prefer the 

default output directory to remain as the location of the first model read in. In D3PLOT and 

T/HIS, a new 'output_directory' preference has been added to control the default output 

directory. For this preference, D3PLOT has options 'LATEST_MODEL_READ' and 

'FIRST_MODEL_READ', with the additional option of 'LEGACY' in T/HIS to preserve old 

behaviour (which was a mix of the two). For both programs, the new default behaviour is 

'LATEST_MODEL_READ'. During a session, if you read in a new model, the default output 
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directory in all menus will update to use the new model's location. However, if you have 

manually selected a different directory for any given output file type, your manual selection will 

continue to be honoured for that file type. 

Part tree 

• Case 49226 

Fixed an issue in the Part Tree where the labels for entities within an include were not changing 

colour when the include's colour had changed. 

Performance 

• Case 48282 

If Quick Pick was used with predictive picking to select include files then the process of 

sketching the contents of the include file could be slow. 

 

In D3PLOT 20.0, the logic has been modified so that if, after starting the sketch, a mouse 

movement greater than a threshold is detected then D3PLOT will now stop the sketch operation 

and will start responding to mouse movements and key presses immediately. 

Program crash 

• Case 50805 

When a model contained both springs and beams, and the option to superimpose beams on top of 

springs for visualisation was used (field BEAM on *DATABASE_BINARY), then a crash could 

occur in predictive picking when highlighting a spring. 

 

This was due to internal confusion between beams and springs in this context and has now been 

fixed. 

• Case 50538 

Fixed a crash that could occur if the option in the Write menu to find and display coincident 

elements was used. 

• Case 50179 

Fixed a crash that could occur if a model containing only the undeformed state was loaded and 

the user then tried to generate a cut-down PTF file. 
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Properties 

• Case 49678 

Fixed an issue that if a command file was recorded from a session containing multiple models 

then none of the actions on the tabs that select and propagate models were recorded in the file. 

PTF compress 

• Case 50591 

In some circumstances, writing out a compressed PTF with fully integrated TSHELLs could 

crash D3PLOT. This has now been fixed. 

Quick pick 

• Case 50544 

Fixed a crash that could occur if the Quick Pick type was set to 'Entity' and then the option to 

dynamically label items on the screen was used. 

• Case 49227 

Fixed an issue where Quick Pick undo was not reverting a part or include to its previous colour, 

overlay colour, transparency, brightness, shine, display mode, or overlay mode. 

Read 

• Case 49394 

On some Windows computers where remote files are hosted on Linux systems and exported via 

a SAMBA server we have seen problems of files being locked unnecessarily when opened for 

reading. A typical scenario is: 

 

- User submits an LS-DYNA job on a remote system 

- User opens results file for viewing in D3PLOT or T/HIS while the job is still running 

- Later, user reopens the results file on the same computer to check progress and finds that no 

more results appear to have been written 

- However, opening the file on a different computer shows that further results have in fact been 

written 

 

To solve this, D3PLOT and T/HIS have been fixed to allow normal updates to occur so that the 

files are not locked unnecessarily. 

• Case 48572 

D3PLOT failed to read the LS-PrePost '.db' files that were generated by the double precision 

version of LS-PrePost. If some of the options to embed precomputed values for von Mises stress 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 20.0 
 

Ove Arup and Partners Limited | Final | March 2023  

 

Page 42 
 

were used in LS-PrePost then D3PLOT would also fail to read those files. These issues have now 

been fixed. 

Selection 

• Case 49061 

When the Ambiguous Pick menu was opened whilst screen picking for a single item (e.g. from 

Deform > Fix Node), if the label option was switched on, D3PLOT would crash during graphics 

refresh once an item was selected from the menu. This has now been fixed. 

Sketch 

• Case 50436 

If a window contained two models then screen picking entities in the first model in the window 

via an object menu could cause D3PLOT to crash. If D3PLOT didn't crash, then the item 

selected was incorrectly marked with pick symbols in the second model rather than the first. 

These issues have now been fixed. 

T/HIS link 

• Case 49553 

When opening a model in D3PLOT with the T/HIS link already open, error message 'the list of 

entity IDs sent from T/HIS for model 2 do not match the IDs in the PTF file. Any unknown IDs 

have been ignored' could be displayed. This has been fixed. 

• Case 49386 

Fixed an issue that could occur with a multiple monitor setup where the main display was not the 

left-hand-most display and the displays had different screen resolutions: when T/HIS was fully 

undocked from D3PLOT (in a linked session), the T/HIS window could become positioned so 

that the top bar was off the screen. This made it very difficult to drag/resize the window as 

required. 

User interface 

• Case 50314 

Corrected the colour of the Apply button in the 'Entities to exclude' portion of the Cut Section 

menu. 

• Case 50305 

When using the XY Data or Write panels, if a model contains composites, it is possible to select 

the ply from which to extract data. However, the feedback box on the Ply Selection panel could 

be obscured by the Help and Dismiss buttons. The panel is no longer docked in the right-hand 

side menu so this feedback box is no longer obscured. 
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• Case 49480 

Fixed a crash that could occur when deleting graphics windows using the popup at the top-left of 

a window. 

• Case 49420 

The Deform panel has been improved: some typos corrected and buttons recoloured for clarity. 

• Case 49159 

In the Data Component Strain submenu, the component listed as 'GXY_GAMMA_ZX_STRAIN' 

has been corrected to GZX_GAMMA_ZX_STRAIN. 

Utilities 

• Case 49872 

When a model was in multiple windows and it was the first in Window 1 but the second in 

Window 2, for example, then Utilities -> Modify title could have applied the new title to the 

wrong model. This has now been fixed. 

Volume 3 

• Case 50965 

With multi-threading on and with models containing multi-physics elements D3PLOT could 

crash when opening a settings file from the File Open panel. This has been fixed. 

Write 

• Case 50069 

Fixed an issue that could cause the Save button in the Write table to become disabled if you 

cancelled a file selection operation. 
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2.3 T/HIS 

Curve menu 

• Case 50129 

In T/HIS 19.0 the labels for the Generalised Stiffness Joint data components were wrong. The 

data components for these joints were incorrectly setup as though they generated x,y,z 

displacement based components when they should have been phi,theta,psi rotational 

components. This has been fixed. 

Curve table 

• Case 50326 

Fixed a crash for D3PLOT-T/HIS linked session curve table writing when models had been read 

in from D3PLOT with no data associated with them. 

Curves 

• Case 48826 

The min/max values in X/Y/Y2 axis will be the same as the values set even in logarithmic scale, 

provided the autoscale is OFF for that particular(min/max) value. 

Errortrapping 

• Case 50665 

On high resolution displays, typically laptops running at 3840 horizontal resolution (around 250 

Dots Per Inch (DPI)) the 'little red button' in the T/HIS dialogue box used to display the number 

of error and warning messages reported could be too small to display anything. It still worked, it 

was simply that no text was written inside it. 

 

This was a scaling issue in the user interface caused by the high DPI value, now fixed. 

FAST-TCF 

• Case 50398 

Fixed issue where backward slashes in all the lines of the FAST-TCF scripts were converted to 

forward slashes when they were read into T/HIS. Now only the file path is converted when read 

in a different platform from which the script was created. 

• Case 49898 

If a FAST-TCF script was generated in T/HIS and one of the curves had been created using the 

'Equation' option then T/HIS would crash if one of the inputs to the Equation was a curve that 

had also been generated using an equation. 
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• Case 49148 

If a FAST-TCF script was pasted into a T/HIS item in REPORTER and the script created a 

number of curves and variables associated with those curves, but only displayed a subset of 

curves, the variables would not be exported to REPORTER correctly. This has been fixed. 

Filename 

• Case 46875 

Previously, the image capture tool in T/HIS would sometimes cause errors by automatically 

overwriting an existing file before presenting the overwrite options. This occurred if you clicked 

the Capture button immediately after entering the name of an existing file into the filename 

textbox, without clicking elsewhere in the window first. 

This error has been fixed, and the buttons have been reworked so that when you click on Apply 

or the Capture button, a popup window appears which lets you decide to either overwrite or 

append the file.  

Additionally, writing a file name in any filename textbox, or selecting a file using the file 

browser, will now highlight the textbox in red if the file already exists. 

Graphics 

• Case 50634 

When creating a curve by clicking on the screen to define points ([Read], Screen mode) the 

graphics of the curve could go wrong if the scale was changed using the mouse scroll wheel, 

leaving what looked like a 'ghost' image of the curve at a different scale. 

 

This was due to a conflict between the way the curve being created was drawn and how scroll 

wheel zoom was working. Now fixed. 

• Case 49603 

All our applications have logic to keep floating menu windows 'in front of' graphics windows so 

that they don't get lost behind them. 

 

This stacking order control was not applied to minimised windows which, as a consequence, 

*could* get 'lost behind' other windows giving the impression that they had disappeared. 

 

Fixed by applying the same logic to minimised windows. 
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Image 

• Case 49467 

Saved and restored the active graphs when the results are captured. 

Integration 

• Case 50337 

In previous versions, the 'PRIMER' panel in T/HIS could, at times, fail to automatically locate 

the corresponding LS-DYNA input model as specified in the ztf file. This issue has now been 

fixed. 

• Case 49506 

REPORTER variables and FAST-TCF table output for curve property MAXA would instead 

give the value MAX. This has been fixed. 

JavaScript API 

• Case 49790 

If multiple graphs were added to a page using the JavaScript function Graph.AddToPage() the 

last graph wasn't being displayed on the page. This has been fixed. 

• Case 49526 

Page.AddToGraph() would throw an exception if there were 32 graphs in T/HIS and one of the 

existing graphs was added to a page, e.g. add graph 1 to page 2, Page.AddToGraph(2, 1). 

 

This has been fixed. 

Output 

• Case 49941 

For sessions containing multiple models, some users prefer the default output directory for 

images and other output files to switch to the latest model read in, whilst other users prefer the 

default output directory to remain as the location of the first model read in. In D3PLOT and 

T/HIS, a new 'output_directory' preference has been added to control the default output 

directory. For this preference, D3PLOT has options 'LATEST_MODEL_READ' and 

'FIRST_MODEL_READ', with the additional option of 'LEGACY' in T/HIS to preserve old 

behaviour (which was a mix of the two). For both programs, the new default behaviour is 

'LATEST_MODEL_READ'. During a session, if you read in a new model, the default output 

directory in all menus will update to use the new model's location. However, if you have 
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manually selected a different directory for any given output file type, your manual selection will 

continue to be honoured for that file type. 

Read 

• Case 49768 

If Option 3 on *DATABASE_ASCII_ELOUT was set, T/HIS failed to read results for Thick 

Shells from the LSDA/binout file correctly. In some cases it failed to read anything, while in 

others it would read the wrong data if a Thick Shell element was fully integrated and had 

multiple in-plane integration points. 

• Case 49635 

Drag and drop of a valid filename now remembers the file location when opened file selector. 

 

Added drag and drop feature to file types Group, Keyword, Bulk Data, ISO Channel/Index, 

Diadem and Nastran. 

• Case 49058 

Fixed an issue where data from THF source files could produce zeroed out PEMAG curve data 

for TSHELLs, SHELLs and SOLIDs. 

• Case 48384 

In LS-DYNA R14 the terms 'slave' and 'master' have been replaced with 'SURFA' and 'SURFB' 

in the ASCII RCFORC and SLEOUT files that T/HIS reads. T/HIS 20.0 has been modified to 

support these alternative files. 

Recent files 

• Case 43524 

Added a popup option for reading multiple models directories. 

Session 

• Case 50555 

T/HIS was unable to write curves from a JavaScript source into an embedded T/HIS session file 

if those curves had an ID that was greater than 9. This has now been fixed. 

• Case 48976 

Added a CHECK BOX whenever 'Embed cur/csv files into session' is unchecked followed by 

checking it first. So when we save the session with embedded files and then uncheck the tick box 
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we would get a conform message saying the saved embedded files(if any) will be lost and ask for 

continue or cancel the operation. 

T/HIS link 

• Case 50301 

Linked D3PLOT<->T/HIS sessions could previously crash under rare circumstances while 

attempting to navigate between pages involving multiple models and specific layouts. 

Additionally, an error message could previously be provoked while attempting to undock T/HIS 

for the aforementioned layout. Both issues have now been fixed. 

• Case 49617 

If you had the environment variables D3PLOT_AUTO_MACRO and THIS_AUTO_MACRO 

set to automatically record a MACRO file then T/HIS would display some %%% ERROR %%% 

messages in it's dialogue box if T/HIS was started from within D3PLOT via the D3PLOT-

>T/HIS link. 

• Case 49383 

If an animation was captured in a linked D3PLOT>T/HIS session then the timeline in the graph 

windows didn't move on the screen - it did however move in the captured animation. 

• Case 49245 

If a T/HIS curve was created by combining data sent across the D3PLOT > T/HIS link with data 

read in T/HIS which did not have an x-axis unit of 'time' then the time based 'timeline' was 

incorrectly displayed on the graph. 

Units 

• Case 49140 

Fixed minor text formatting in the Units menu. 

-Added spaces after commas (mm, kg, s) 

-Made capitalisation more consistent 

-Changed the order from (Mass, Length, Time) to (Length, Mass, Time) in the display to make it 

consistent with PRIMER and the popup. 

• Case 47800 

The layout of the HDF panel has been improved, and it now responds better to resizing. 

Write 

• Case 49757 

Now T/HIS will update the file paths for file browser in case the user drags a file into a T/HIS 

session. 
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2.4 REPORTER 

Animation 

• Case 50982 

After navigating to a new page in REPORTER, the playback speed of animated Items is now 

updated to match the current value shown in the animation toolbar. 

• Case 50983 

When duplicating a page, items on the new page would sometimes be located at incorrect 

coordinates. This could occur if a user had previously copied an item to the clipboard and right-

clicked somewhere on the current page without then pasting the item. This issue should now be 

resolved. 

Errortrapping 

• Case 49982 

If you insert a variable that does not exist in the report/template, REPORTER will now only log 

one error when the report/template is generated. REPORTER will no longer log an error when 

failing to render the missing variable in Presentation view. 

Filename 

• Case 50434 

REPORTER now automatically adds any missing extensions to file names when you save a new 

file from REPORTER. Your selected file filter will be used to add the appropriate missing 

extension. 

• Case 49570 

Fixed an issue introduced in REPORTER 19.1, in which a user-defined 'Image File' filename for 

a new PRIMER/D3PLOT/T-HIS Item was being overwritten by a default name when first 

creating the Item. 

• Case 49468 

When modifying a PRIMER, D3PLOT, or T/HIS Item in REPORTER, the file browser launched 

by the Choose button for the Image File field will now allow for the creation of a new file. 

Previously, only an existing file could be selected. 

Library 

• Case 50349 

The following scripts have been deprecated in REPORTER 20: 

pedestrian_zone_area_from_csv.js and pedestrian_zone_area_from_variables.js. It is 
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recommended to use the HIC Area Calculator in PRIMER and the Euro NCAP and GTR Head 

Impact templates in REPORTER instead. 

Menus 

• Case 50054 

In rare circumstances following modification of the OA_INSTALL environment variable, it was 

possible for the 'New Library Page...' Dialog to prompt a crash to desktop. This is no longer the 

case. 

Preferences 

• Case 50317 

REPORTER will now ignore any environment variable whose name includes non-word 

characters. Previously, REPORTER incorrectly allowed a sequence of non-word characters at 

the beginning of an environment variable name. This meant that '#OA_HOME' (for example) 

would have been interpreted as 'OA_HOME', leading to unexpected consequences for users. 

Session 

• Case 49174 

When exporting a template to a report, the REPORTER session will no longer update (i.e. the 

session remains as the current .ort/.ortx). 

Standard templates 

• Case 50089 

The Automotive library templates allow you to process results located in a different directory 

from your keyword file (to accommodate HPC clusters with this configuration). However, the 

D3PLOT items in several templates were found to be lacking this feature, and would throw an 

error unless the results were in the same directory as the keyword file. This has been fixed for the 

following templates: 

Euro NCAP Far Side Impact 2022 

Euro NCAP Side MDB 2022 

Euro NCAP Side Pole 2022 

IIHS Side MDB 2021 

IIHS Side MDB 2021 Structure Only 
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Text 

• Case 48794 

When mapping fonts, if the default font is not available for a generic type (sans-serif, serif, etc.) 

then REPORTER now searches for the first available font of the same type before switching to 

the default sans-serif as a last attempt. 

Write 

• Case 50448 

When saving a Template to a new location using the 'File -> Save As' 

option, the 'Read-Only' label will no longer persist incorrectly in the 

REPORTER title bar. 
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2.5 SHELL 

Case 

• Case 40251 

LS-DYNA job submissions with the *CASE option could crash certain versions of the MPP LS-

DYNA executable.  It was found that this could be prevented by performing the submission with 

a 'names' file. SHELL does not create a 'names' file for a LS-DYNA submission with the *CASE 

option. 

In V20 we have added a new SHELL preference “create_names_file” to allow user to choose 

whether to 'ALWAYS' or 'NEVER' create a 'names' file during LS-DYNA submission. The 

default value of this preference is 'PRE-V20' - which will create a 'names' file for non-CASE and 

no-MCHECK option submissions and otherwise. 

 

Edit 

• Case 50286 

The text editor other than machine default was sometimes not launching on a Linux machine. 

This has been fixed. 

Memory 

• Case 46654 

The 'Consistency Flag' option has been deactivated for the MPP run of the LS-DYNA in the 

SHELL. Also if the number of CPUs in just 1, the option value is not inquired in the command-

line SHELL. 

Menus 

• Case 47684 

Text fields in SHELL were non-responsive and wouldn't take keyboard input, when we 

alternated between SHELL and other programs, this has since been fixed. 
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3 Enhancements 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

3.1 PRIMER 

Belts 

• Case 49991 

Added a new feature to the seatbelt fitting tool that allows effortless path definition at an 

explicitly meshed shoulder slipring (D-ring) and automatically pulls the slipring into its correct 

position during the fitting process. 

• Case 49990 

Seatbelt fitting tool: Changed the behaviour of the red twist handles in the ‘Advanced’ path 

definition settings so that any handle can be modified independently without affecting red 

vectors at neighbouring path points. 

• Case 49989 

Seatbelt fitting tool: Added the option to fit belt segments independently. 

• Case 48513 

Added automatic creation of stiffener beam option between two base path points. The user needs 

to define part id that needs to be used for number of beams to be created. PRIMER will 

automatically create number of beams on seatbelt using the part id given by the user. 

• Case 48511 

Enabled changing current layer of include while creating seatbelt definition. 

• Case 42694 

Added Write CSV option in seatbelt path definition panel to write out seatbelt path point 

information. 

Checking 

• Case 49569 

When checking a mechanism it will report if nodes or parts are incorrectly defined in more than 

one assembly, but in any location other than the mechanism positioner itself it did not provide 

any details of which nodes or parts. 

 

This is now fixed so that in the context of a free-standing check of a mechanism the ‘details’ 
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output option will list the parts and/or nodes in question and also the assemblies in which they 

are present. 

• Case 48457 

The orthogonality check on universal/cv joints has been improved so error is reported if 

misalignment is > 1 degree, warning if > 1/1000th radian (a somewhat severe test). Additionally, 

there are Autofix options to correct misalignment. 

• Case 46552 

Added warning for *CONTROL_IMPLICIT_SOLVER, if AUTOSPC is set to 2 (turned off), 

LS-DYNA analysis will ignore unconstrained/unattached degrees of freedom in stiffness matrix. 

 

Added warning for *CONTROL_IMPLICIT_INERTIA_RELIEF, if THRESH is a positive 

value, LS-DYNA analysis might not find all rigid body modes correctly if negative frequency 

modes are reported. 

• Case 44977 

A warning has been added when using second order shells with ELFORM 16. 

• Case 43850 

New material orthotropic option check: 

- If AOPT = 2, check that vector A is not parallel to any SHELL normal 

Coating 

• Case 48918 

Coat part tool has been enhanced to coat hole edges and/or free edges of shell parts with beams 

or 1d segments. 

• Case 48089 

New option to coat high order solids considering the interpolation nodes. 

Comments 

• Case 48459 

The comments ‘WARNING... was referenced but not defined’ & ‘USAGE....’ messages will no 

longer be written when the ‘Xref comments’ option is turned off during keyout. 

Connections 

• Case 49660 

The elements around hole were not retained if it is within remesh diameter during spotweld 

remeshing. Now, an option ‘Preserve shells around hole in the HAZ remesh zone’ is added in the 
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connection option panel which can be enabled to preserve elements around hole. The user can 

also enter size of hole in ‘Max hole diameter to preserve’ textbox which should be preserved. 

• Case 48788 

Added new option ‘Mesh size for adhesive patch’ by which the user can specify the mesh size 

for the solid elements which will be extruded from quad biased grid. If this option is not turned 

ON, then PRIMER will use average size as before else will use the size specified by the user. 

• Case 48476 

The stored/default settings column is now displayed by default on connection table and a 

warning is given if ‘options’ is activated when stored settings apply to 1 or more connections. 

• Case 48443 

Spotweld and adhesive connections have a new test for nodes that tie but do not lie on the 

surface of the attached layers. These incur out of plane error. This means the connection needs a 

reproject. 

The tolerance is 0.01*spot_thickness which is 1/10th mm for model in mm. 

• Case 42919 

The connection compare tool has been enhanced with new options to display only the 

connections that appear on the table and to only consider connections in the visible domain. 

• Case 39055 

Added a new option in connection panel to skip spotweld remeshing if the connection is close to 

something like NRB which would be modified. 

Crash test setup 

• Case 49212 

In the barrier settings of the IIHS Small Overlap Right or Left load case, an option to use the 

default impact side was added. This will allow the user to easily select the default barrier impact 

side and is active by default. 

• Case 49211 

The Batch Crash Test Setup script can now do a Frontal Rigid Wall load case. To select this case 

in the batch script, in the main Crash Test Setup script, the user must save the EuroNCAP Full 

Width Frontal Impact with the ‘Use Rigidwall’ option ticked to the user or system tests. The 

Frontal Rigid Wall load case will then be available in the batch script by running the user created 

test. 

• Case 49182 

Changes to the Occupant’s Head – Center of Mass panel allows the user to specify up to three 

head positions. The head positions can be written to the vehicle xml file and reused later. If more 
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than one head position is defined, the script will do the barrier setups for the different head 

positions successively. 

If the user runs multiple head positions in the batch script, a ‘_head_position_’ + setup number 

suffix will be added to the name of the keyword file to distinguish between the different head 

positions. 

• Case 49181 

Crash test setup: Added the option to ‘Filter by’ in the test selection window in the batch crash 

test setup script (like the one in the main script). 

• Case 49180 

Crash test setup script: Added the option to skip the Import Include Transform window when 

importing the barrier model through a new preference Skip Import Include Transform Window 

and the option to save/import the labelling offsets and the DEFINE_TRANSFORMATION ID 
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(TRANID) into/from the barrier settings through the ‘Apply labelling offsets to include 

transforms by default’ preference. 

• Case 49064 

The Batch Crash Test Setup script now reuses vehicle models if they are the same for multiple 

setups rather rereading the same model. This will speed up the script as it skips unnecessary 

rereads of vehicle models. 

Curves 

• Case 47048 

When adding points in DEFINE_CURVE and adding entries in DEFINE_TABLE, the graph is 

now autoscaled automatically. This can be disabled with the toggle button ‘Autoscale’. 

• Case 23427 

Added two ‘Log’ buttons to the DEFINE_CURVE and DEFINE_TABLE editors that can be 

used to set the graph x and/or y axis to a logarithmic scale. 

Cut Section 

• Case 49904 

Previously in PRIMER, in Cut Sections panel at least one direction switch was turned on by 

default. Now we can have the cutting switch turned on/off with no direction switches turned on. 

In the case where no direction switch is active, we show the entire model. 

• Case 46164 

Added the functionality to exclude part/set from the cut-section. 

Database 

• Case 49044 

Options 1-4 fields now supported for the BNDOUT entry of DATABASE (ASCII). 

Dummies 

• Case 49931 

When users go through dummy/HBM positioning, a joint check is now performed upon 

progressing through the stages. If joints are out of place, then an automatic Autofix is performed. 

• Case 49890 

Users can now control the rotation and translation locks for all assemblies at one time within the 

Mechanism positioning panel. Popups found under the ‘Lock tr’ and ‘Lock rot’ buttons. 
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• Case 49774 

Users can now set ‘Permit Rotation’ for all assemblies at once, per axis. Find popups in the 

‘Rotate Angles’ panel on the Phi, Theta, and Psi buttons. 

• Case 49593 

To make it possible to combine arbitrarily connected dummies/HBMs with mechanisms it is now 

possible to convert a *DUMMY definition (as defined by its tree file) into a *MECHANISM 

definition. In this process the dummy/HBM assembly definitions are unchanged but the tree 

connectivity between them is converted into mechanism connections. Dummies/HBMs can also 

be imported directly into existing mechanisms, being converted in the process. 

 

Dummies/HBMs converted in this way are ‘true’ mechanisms which can be combined with 

existing mechanisms as siblings, doing away with the parent/child limitations of a dummy/HBM 

imported into a mechanism as a child. This dispenses with the hierarchical dummy/HBM ‘tree’ 

and permits arbitrary connectivity between assemblies. 

• Case 49152 

If users perform a node import to a dummy/HBM containing sliprings, then they may find that 

the seatbelts pass through the sliprings, leaving the sbid1 and sbid2 variables wrong. 

 

Users can now choose if they want to automatically update these variables (for all sliprings) after 

reading in a dynain file. Alternatively, users can fix an individual slipring through the Autofix 

method within a model check. 

• Case 48966 

Dummy/HBM position panel now has feature to Undo/Redo assembly positions. 

• Case 48964 

The reading in of dynain files (through Node Import and Seatsquash) is now more accepting of 

severe errors. Severe errors are skipped over, rather than terminating the process. 

 

This is now the default choice. However, users can turn this off through the 

‘skip_severe_errors_dynain’ preference. 

• Case 48781 

Dummy/HBM users can now manipulate the columns of the ‘T All’ and ‘R All’ buttons for 

assembly positioning. These options can be found under the ‘Lock tr’ and ‘Lock rot’ text titles, 

with the options of selecting: All, None, Reverse, All x, All y and All z. 

• Case 48694 

Users are now able to mirror the positioning of a HBM dummy, via Safety → Dummies → 

Position → Move Parts. 

 

Opening the mirror panel here provides options for the axes of reflection and the direction of the 

mirroring. 
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Opening individual assembly panels (via the buttons in the Move Parts panel) allows for 

mirroring individual assemblies and access to the assembly pairs. 

• Case 48502 

The encrypted include file can now be added into the Include tree from within the PRIMER 

‘Include Tree’ panel. 

Also enabled certain useful popup menus for the encrypted include files in this panel. 

• Case 48494 

Users can now add new SET_PARTs and SET_NODEs to dummy/HBM assemblies, even with 

an encrypted dummy tree. This can be accessed through Tools → Safety → Dummies → 

Modify. 

Encryption 

• Case 49649 

When definitions such as materials, load curves and parameters in an input deck are wholly 

encrypted it can cause problems if PRIMER does not ‘know’ that the labels of these definitions 

are in use. One way round the problem is to have a *ENCRYPTED block after *END which 

contains simplified copies of these definitions which PRIMER reads but LS-DYNA does not. 

 

This works but the existing method of putting all such definitions within a single 

*ENCRYPTED_START ... _END block was problematic for some workflows so an alternative 

format which places each material, curve, etc inside its own *ENCRYPTED_START .. _END 

card pair has been introduced. 

 

This is controlled by the preference 

 

primer*keyout_post_end_encrypted OMIT | INDIVIDUAL | COMBINED 
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where ‘combined’, the original format, remains the default but ‘individual’ gives the alternative 

of individual headers per definition. 

• Case 49559 

The encryption tool now supports *AIRBAG, *ELEMENT_SEATBELT_RETRACTOR, 

‘ELEMENT_SEATBELT_SLIPRING, *ELEMENT_SEATBELT_PRETENSIONER, 

• Case 48287 

Adding a new feature that allows you to apply full encryption to individual keywords at scale. 

Geometry 

• Case 49049 

It is now possible to open IGES and STEP files in PRIMER on the command line, and by double 

clicking on the file in windows. 

• Case 46710 

Now ‘Geometry options’ that include ‘Curve Segs’, ‘Surf Segs’, ‘SH Overlay’, ‘Tolerance’, 

‘Merge Tol’, ‘Ignore curves <’, ‘NURB tol’, ‘Max trim split’, in ‘Display Options’ panel in 

PRIMER can be saved as preferences in oa_pref file using ‘save display settings’ button. 

• Case 24994 

PRIMER 20.0 can now read STEP files (beta). 

Graphics 

• Case 48722 

A new ‘Generalised Graphics’ capability has been added to PRIMER. This is really for internal 

Oasys LS-DYNA use when we wish to create a single graphical entity which is an arbitrary 

mixture of underlying primitive types. I typical use is in the assemblies used to position Human 

Body Model dummies since these tend to contain an eclectic mixture of components which span 

across part boundaries. 
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The capability is available users under [Tools] Other but you should probably seek advice from 

Oasys Ltd before attempting to use it as part of a workflow. 

• Case 35300 

Users can now choose between Model - Title/Filename/Path to be displayed in the graphics 

window by using the new radio buttons in Display → Options panel. 

IGA 

• Case 48525 

PRIMER can now calculate mass of IGA shells and display them in the Part table, Mass 

Properties and Summary file output and Contouring visualisation. 

• Case 48392 

Added view interpolated element functionality in IGA Refine panel. 

• Case 48339 

In *ELEMENT_SHELL_NURBS_PATCH edit panel, we have added an option to visualise 

interpolated elements grid. 

• Case 46269 

Added IGA Options in CNRB panel, which will enable users to create number of nodes and 

IGA_POINT_UVWs on IGA_1D_BREP (trimming loop), anywhere on IGA_SHELL 

automatically. 

 

Also updated IGA_POINT_UVW create panel such that users can create IGA_POINT_UVW by 

picking anywhere on IGA_SHELL or on IGA_1D_BREP (trimming loop) automatically. 

 

PRIMER will also add IGA_POINT_UVWs on SET_IGA_POINT_UVW on corresponding 

IGA_FACE_XYZ definition. 

JavaScript API 

• Case 49699 

We have added JavaScript API to support sketching and selection of Dummy’s assemblies. 

• Case 49690 

Element property settings options like parametric coordinates, integration points, min strain and 

max strain can now be enabled using JavaScript API. These are applicable for Plastic strain, 
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form, area, and volume in element property setting. ‘Parametric coordinates’ is the default option 

if the third argument is not passed while calling the function, 

• Case 49177 

Added COLOUR_LATENT for widgets in JavaScript API. 

• Case 48676 

Added *INITIAL_STRAIN_SHELL and *INITIAL_STRAIN_SOLID to JavaScript API 

• Case 47786 

The connection bolt option ‘use_parent_layer’ can now be set/unset in JavaScript by 

Conx.UseParentLayer() 

• Case 47483 

From LS-DYNA R13.0, on *DATABASE_CROSS_SECTION_PLANE the fields XCT and 

XCH would be defined as node IDs if RADIUS was negative. This was supported in the main 

body of PRIMER but not in the JavaScript API. This support has now been added to the 

PRIMER JavaScript API. 

• Case 47482 

The Contact class in JavaScript API now takes into consideration the following regarding 

complex fields BT and DT: 

 

If DT = -9999, BT is interpreted as the curve or table ID defining multiple pairs of birth-

time/death-time. Otherwise, if DT > 0, birth time applies both during and after dynamic 

relaxation. 

• Case 47018 

‘AspectRatio’, ‘Jacobian’ and ‘Warpage’ member functions have been added in the classes Solid 

and TShell. 

• Case 46741 

Users can now specify any existing retractor id in the model using SetMesh in belt JavaScript 

API. 

• Case 46740 

Added a property for retractor class called ‘nsbi’. Users can get and set number of seatbelt 

elements inside retractor using it. 

• Case 46353 

1) Added new LS-DYNA R13.0 VOLFRAC field to *MAT_ADD_EROSION keyword. 

2) Deprecated old *MAT_ADD_EROSION JavaScript API methods. 
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3) Added new JavaScript API support for *MAT_ADD_EROSION & 

*MAT_ADD_DAMAGE_GISSMO keywords. 

• Case 46093 

The Material JavaScript API now contains a typeNumber property that provides the material 

type in the number format (‘001’, ‘034M’ etc.) 

• Case 42147 

Added JavaScript API support for *FREQUENCY_DOMAIN_FRF (class FreqFRF) and 

*FREQUENCY_DOMAIN_SSD (class FreqSSD). 

• Case 32512 

Radio button widgets have been added to JavaScript. 

• Case 15582 

Added new JavaScript API classes for *INITIAL_STRESS_SOLID and 

*INITIAL_STRESS_BEAM. 

Keyword Editor 

• Case 47491 

In *AIRBAG_PARTICLE the radio buttons have been repositioned to avoid so much blank 

space in the panel. 

Mass 

• Case 48569 

When reporting mass of model with *RIGIDWALL with _PLANAR = 1, PRIMER now gives 

mass properties both with/without the rigid wall. If value of RO is zero, the default 1e-9 is now 

used in the calculation. 

• Case 47709 

Assign mass panel on calculate shows the proposed mass properties before the assign mass is 

made. This allows users to easily modify the target definition to tune overall mass properties. 

Materials 

• Case 46268 

USER_DEFINED_MATERIAL_MODELS have been extended to include the materials in the 

range 281-290. 
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Measure 

• Case 48510 

Users can now see the vector magnitude displayed when creating a new *DEFINE_VECTOR. 

• Case 47309 

Added new Measure mode: Node to Line. 

Menus 

• Case 48819 

The button ‘Script’ from the PRIMER Tools menu is now called ‘JavaScript’. 

Mesh 

• Case 50097 

Added a new option ‘Add nodes around spotweld to improve mesh quality’ in connection 

creation options panel. When turned ON PRIMER will add few new nodes around spotweld to 

improve the quality of mesh produced after spotweld remesh. This option works with HAZ mesh 

reconstruct. 

• Case 49137 

A new option ‘Preserve elements around hole’ is added in Remesh area panel. When ON, 

PRIMER will preserve all elements while remeshing which are present immediately around hole. 

By specifying ‘Max hole size’, users can control which hole elements should be preserved. 

• Case 46051 

Added ‘First Align’ and ‘Second Align’ options to TSHELL → Align panel. TSHELLs can now 

be aligned by specifying either or both axes. Axis alignment can also be done by specifying a 

vector direction. 

Orient 

• Case 47920 

Single node picking buttons in the Orient panel changed to display the ‘Select Node’ panel 

which allows defining a node through selection or node number (‘key_in’ option). 

Parameter 

• Case 48145 

Fields referring to latent or encrypted parameters will be written as &name (where ‘name’ is the 

name of the parameter) even when the pre-output option ‘Write Parameters as values’ is set to 
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TRUE. Previously, this was written as the default value ‘0’. The only exception is for the IDEAS 

output format that does not support the concept of parameters. 

• Case 48044 

When a field refers an entity like node and defined by a parameter, and when the entity is 

renumbered, we get a panel that suggests options to modify the scalar parameters. 

 

This has now been extended to expression parameters by having an option inside the old panel. 

This brings up a new panel with options for both scalar and expression parameters. 

 

A new option has also been introduced to leave the field untouched (original case). 

Part replace 

• Case 47899 

Remake of spotweld beams was reported to have removed the beams from a set used in 

*CONTROL_SPOTWELD_BEAM. 

Some generic logic has been added to remake solid/beam sets where all the entities of the 

connection are in the set. 

Pedestrian 

• Case 49528 

Support has been added to the Pedestrian Markup tool for the 03 series of amendments to the UN 

R127 protocol (issued in 2022). These changes are accessible by selecting the ‘GTR / UN R127 

(2022)’ protocol - the previous version of this protocol is still accessible via the ‘GTR / UN 

R127 (pre 2022)’ protocol. 

 

Control over the calculation of the windscreen zone is available through the Windscreen Zone 

Markup Parameters window (accessible through the Windscreen Zone ‘Define...’ button). This 

window offers the ability to choose whether the offset lines are calculated from the edge of a 

windscreen obscuration part or from the free edge of the windscreen part. The offset distances 

for these lines are editable through this panel, or via corresponding command line/settings file 

options. When the calculation is performed without an obscuration part a pseudo obscuration 

width can be applied in addition to the front and side line offset distances, to mimic the presence 

of an obscuration part. 

 

Finally, the head impact points window has been updated to allow the control of the new 

Windscreen/Cowl zone Child and Adult head impact points, and specification of corresponding 

impactor orientation angles. 

• Case 49100 

Added a new Head impact point labelling scheme to the Pedestrian Markup tool - Coordinate 

labelling. This will assign a label to an impact point based on the impact point’s coordinates of 

the format: P_XXXX_YYY; where P is the point name (‘A’ for adult etc.), XXXX is the x-

coordinate of the point, and YYY is the y-coordinate of the point. If a duplicate label occurs, the 

duplicate will have the corresponding impact point’s z-coordinate appended to the end: 
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P_XXXX_YYY_ZZZZ. Further duplicates to this label will then have a counter index appended 

to the end. 

• Case 47710 

The ability to use CAD model as input for Pedestrian Markup Script has been added to PRIMER. 

Penetrations 

• Case 47428 

By default, contact of beam-beam and beam-shell elements with 

CONTACT_AUTOMATIC_GENERAL now uses an enhanced algorithm which will give more 

rigorous penetration detection. Program options > contact > beam contact method can be 

switched back to basic method. 

Performance 

• Case 44560 

Editor panel buttons formatted their text using ‘left justification with leading white space’, for 

example [_______10] where ‘_’ is white space. 

 

This meant that clicking to the left of a number positioned the cursor in white space rather than 

immediately in front of the first digit. It also meant that using the [home] keyboard button to 

reposition the cursor at the start of the string in fact positioned it at the start of that leading white 

space, also that a triple-click to select the whole string would select both white space and 

number. 

 

This has been fixed in two related ways: 

- Text is now centre-justified in editor buttons with no leading white space. This causes some 

minor changes to the positioning of numbers in buttons, but in most cases, you would need to put 

‘old’ and ‘new’ side by side to spot any differences. 
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- Where text still does have leading white space then a click ‘in front’ of the number or using the 

<home> key will now position the cursor in front of the leading digit. 

Quick pick 

• Case 46136 

Quick Pick now supports *INITIAL_AXIAL_FORCE_BEAM and 

*INITIAL_STRESS_SECTION 

• Case 45819 

Unblank option added for SET types of NODE, BEAM, BOX, PART, SHELL, SOLID, and 

TSHELL. 

Read 

• Case 47759 

Primer can now read include files with negative labels having sufficient 

*INCLUDE_TRANFORM offset. 

• Case 45967 

Added a new pre-output check option ‘Post *END data’ that controls writing data after *END. 

This overrules other options/preferences that control writing specific types of data (for example: 

‘write out all connections’). A preference variable ‘db_write_post_end_data’ connected to this 

new option was also added. 

Scripting 

• Case 48303 

The following changes have been made to the Multi Param Script, to improve users’ 

understanding of how to utilise the script: 

- Addition of a help button. 

Which provides an explanation and an example of how to create a valid CSV file to be used 

within the script 

- Increased UI window size 

To accommodate the new help button. 

• Case 47708 

Seatbelt Anchorage Enhancements: 

- Panel reorganisation and help images added 

- Option to create *DATABASE_HISTORY cards for Loading Beams and Belts 

- Options to change Section and Material ID’s for Seatbelt 

- Contact between Body Block and Seatbelt created 

- Items created by the script sent to a *SET_PART_COLLECT_TITLE 

- Options to control Seatbelt length, width and thickness 
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- Option to change input load keyword from *LOAD_NODE to 

*BOUNDARY_PRESCRIBED_MOTION_LOAD 

- New Inertia Centre of Gravity options using coordinates or seat structure part set 

- Vehicle Category option added which automatically sets load on blocks and seat inertia loading 

values as per specification 

- Option to change body blocks from *PART to *PART_INERTIA 

- Errors in Formers removed 

- Option to use your own formers by selecting a user-defined directory 

- Option to re-number meshing start labels 

• Case 41705 

Seat belt options for the SBA script moved from Settings panel into the main input screen. 

Selection  

• Case 48681 

When using object menus to filter by include file the option to choose the current include (layer) 

has been added to the list of files in the menu. 

Sets 

• Case 47940 

Creating a set by picking or multiple area selections can result in out of order items. A switch 

‘Re-order items’ has been added to the set view/edit panel. 

User interface 

• Case 50554 

The ability to create a list of Favourite Tools or Favourite Keywords was added in PRIMER 

19.0. Now, options from the Mesh Tools list can also be added to Favourite Tools. Additionally, 

greater granularity has been added so that individual sub-keywords can be added to Favourite 

Keywords directly. 

 

Further additions to this feature: 

- A filter has been added to make it easier to find Tools or Keywords to add to Favourites 

- The ability to specify custom button text for standard Tools and Keywords in Favourites has 

been added 

- Popup buttons can be created for Favourite Tools to allow options to be grouped together 

- The Edit Favourites panel now uses a tree widget to display the hierarchy of buttons more 

clearly 

- Admin-specified Favourites options (e.g. organisation-wide Tools) can be saved in oa.conf file 

(see below) in the OA_ADMIN directory. These will be locked for editing by individual users so 

they will always be present for them. 

To better support these additional features, Favourite Tools & Keywords data is now saved to a 

user’s oa.conf file, instead of their oa_pref file. Favourites options saved in the oa_pref file prior 
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to PRIMER 20.0 will still be read into PRIMER at this time, but any changes made will not be 

saved out to the oa_pref file, as this is now deprecated functionality. When starting PRIMER 

20.0, Favourites options in the oa.conf file will take precedence over those in the oa_pref file. 

• Case 48440 

The connection options panel has been re-designed. The order and the wording of some options 

has been improved. And help buttons with direct links to the relevant sections of the manual 

have been added. 

• Case 46154 

Labels ‘Set ESORT = 1’ and ‘Create true thickness solid’ in Mesh Extrude panel of PRIMER 

now have tick boxes instead of toggle buttons. 

• Case 43481 

Custom JavaScript Tools (created using the PRIMER JavaScript API) can now be added to your 

Favourite Tools. 

Volume 3 

• Case 43058 

Updated definition of pressure ‘p’- for Outlet type boundaries in ICFD setup script. This is the 

prescribed relative pressure (zero for atmospheric conditions). 

Write 

• Case 49765 

The ability to install Analysis Tracking Tool and setup keyout hook has been added to PRIMER. 

• Case 48210 

PRIMER can now write out in free format (comma - separated files) for all keywords 

irrespective of whether the fields contain parameter or not. The original enhancement was meant 

for INITIAL_STRESS and INITIAL_STRAIN keywords, but options have been provided to 

write them out for all keywords as well. Nothing will be written between the commas if the data 

in the field is zero. 

X-sections 

• Case 48314 

Previously Reverse Direction button in DATABASE_CROSS_SECTION create menu did not 

redraw the reversed directions instantly, it either needed a graphics update event (moving the 

cursor in graphics window etc.) or clicking the sketch button in the 

DATABASE_CROSS_SECTION create menu. 

This is now fixed. and redraw is instantaneous. 
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3.2  D3PLOT 

Annotation 

• Case 7144 

D3PLOT 20.0 includes a new Tools → Annotations feature, enabling you to annotate your LS-

DYNA results in 3D with descriptions, comments, and insights to share with your team and 

partners. 

 

- Capture a series of page views with a title, description and markers that can be simply reloaded 

- Save annotations to a file for retrieving in a later session of D3PLOT 

- Display annotations in a playback mode for simple presentation to colleagues 

- Annotations saved with one set of models can be reloaded with a different set of models 

allowing annotation ‘templates’ to be created. 

Cut section 

• Case 49906 

Previously, in the Cut Sections panel, at least one direction switch was switched on by default. 

Now, the cutting switch can be switched on/off with no direction switches switched on. In the 

case where no direction switch is active with the cutting switch on, we show the entire model for 

all the active windows. 

• Case 49606 

Parts excluded from the cut plane are now also excluded from the total force calculation. The 

Write table launched from the Forces button in the Cut Section menu no longer shows forces for 

excluded parts. 

• Case 48959 

The ability to add a cut section capping colour for 2D shells has been added. Additionally, a cut 

outline for solids, shells and thick shells can also be toggled on and off. Both features allow you 

to customise the thickness and colour of the capping/outline. 

• Case 42789 

When D3PLOT cutting planes intersect shell elements these are 'capped' with a cut face. By 

default this uses either a fixed thickness value or the actual true thickness of the shell element. 

An option has been added to use the contact thickness defined on *PART_CONTACT. 

 

With this option active: 

 

If OPTT is defined that thickness is used verbatim. 

If SFT is defined that factor scales the true thickness of the shell. 
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For this option to function correctly, a ZTF file must be present to provide information about 

*PART cards. Without a ZTF file, the capping will revert to the unfactored true shell thickness. 

Deform 

• Case 44584 

The deformation magnification value is now visible in the bottom-left corner of the graphics 

window by default, unless the magnification is equal to unity (1.0 x magnification). Controls to 

toggle on/off the visibility of these values and customise the number formatting for these values 

are available under the Display Option sub-header in the Deform -> Magnify panel. Another 

button to toggle the visibility is also under Display Options -> Window Dressing. A new 

dialogue command DISP_MAG_SWITCH under DISPLAY_OPTIONS has been added. New 

preferences d3plot*plot_disp_mag and d3plot*footer_size have been added to control default 

behaviour. All these settings can be saved and retrieved from settings files as required. 

Dialogue command 

• Case 49066 

SHOW_NODES_ON and SHOW_NODES_OFF have been added as dialogue commands to 

DEFORM > REF_NODE to switch on and off the display of the selected nodes. 

• Case 48642 

Added dialogue command history into PRIMER, D3PLOT and T/HIS. You can now use the Up 

and Down arrow keys to scroll through previously issued commands which can be used to 

reissue them. 

JavaScript API 

• Case 49568 

A ModelExists() function has been added to the JavaScript API so that you can check whether a 

model exists in the database. 

 

Previously you could use SetCurrentModel() to check if a model existed, but it issued an error 

message if it didn't exist, e.g. 

 

let n = GetNumberOf(MODEL); 

 

for(let i = 1; i <= n; i++) 

{ 

if(SetCurrentModel(i)) // TRUE if present 

{ 

// do something... 

} 

} 
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You can now do: 

 

let n = GetNumberOf(MODEL); 

 

for(let i = 1; i <= n; i++) 

{ 

if(ModelExists(i)) // TRUE if present 

{ 

SetCurrentModel(i); 

// do something... 

} 

} 

 

And you will no longer get the error message. 

• Case 48971 

Enhancements for the D3PLOT JavaScript API: 

- Functions Blank() and Unblank() can now accept strings ('ALL', 'ALL_DEL' etc.) for the 

<item> parameter 

- Functions Blank() and Unblank() can now accept number arrays for the <item> parameter 

- New function NumDeleted() is now available 

- New function GetContourLimit() is now available 

- New function GetConditionParts() is now available 

Preferences 

• Case 49753 

Several new preferences have been added that allow you to change the default beam symbol, 

default line thickness for thick beam symbols, and switching on/off spot weld beam end caps. 

Text 

• Case 49623 

A new option has been added under Display Options to toggle on/off the 'D3PLOT: ' prefix in 

model titles/filenames. 

Workflows 

• Case 39020 

Added a Strength Check Workflow tool to D3PLOT. This tool allows you to quickly visualise 

and cycle through parts containing yielding elements. 

• Case 34330 

A new 'Workflows' feature has been added to the Oasys Suite 20.0 to make it easier to 

interrogate and post-process results. It allows you to tag your models in PRIMER with data 

which can then be used in D3PLOT and T/HIS to provide relevant tools for post-processing 
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analysis results. 

 

This release contains a collection of tools: 

 

- 'Automotive Assessments': Allows you to tag your model with relevant data such as crash test 

type and a description of the occupants and structural items in the model. With this data 

D3PLOT and T/HIS can create graphs and images following the rules set out in a crash test 

regulation, such as Euro NCAP or IIHS. Results from multiple models can be interrogated at the 

same time, making it easy to compare results from different runs. 

 

- 'Eroded Elements': Visualise deleted elements at different states in D3PLOT. 

 

- 'Strength Check': Visualise yielding parts in D3PLOT. 

 

- 'Intrusion Contour': Visualise an intrusion plot in D3PLOT. 

 

- 'Pulse Index': A tool to tag a model with data required to carry out a pulse index analysis in 

T/HIS, to estimate the acceleration that would be experienced by an occupant in a crash test. 

 

- 'Energy Check': Plot total energy, kinetic energy, internal energy and hourglass energy in 

T/HIS 

 

- 'Entities of Interest': Allows you to tag your model with groups of parts. This can be used in 

D3PLOT to show the groups of parts, highlight them and export them to a GLB file to view in 

D3PLOT Viewer 

 

We plan to update the existing tools in future releases as well as adding new tools. If you have 

any ideas for additional features you would like to see in the existing tools or any ideas for new 

tools, please contact Oasys Ltd. 

 

In addition to the tools provided it is possible for users to add their own bespoke tools. Please 

contact Oasys Ltd if you have an idea for a tool and would like some help creating it. 
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3.3 T/HIS 

Curve menu 

• Case 48656 

In the Style menu, you can use the Search and Replace fields to make bulk modifications to 

curve labels. The characters '^' and '$' can be used to insert or append the replacement string at 

the start or the end of each label respectively. In T/HIS 20.0, the asterisk character '*' can now be 

used to replace the entire label of the selected curve(s) with the specified replacement string. 

General 

• Case 47773 

The new features HDF panel supports for V20 are: 

1) Curve history support 

2) FastTCF and dialog input support 

3) Multiple selection for Y axis 

4) Convenience functions 

5) Attribute data is read in and supported now 
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6) The panel has been redesigned 

7) FastTCF now supports column label for compound datasets 

JavaScript API 

• Case 49782 

A new member function IsOnGraph() has been added to the Datum class. This makes it possible 

to check if a datum exists on a graph or not. 

Operations 

• Case 49436 

Added CORA and MADM Buttons to Automotive panel in T/HIS 

Preferences 

• Case 48486 

Added a preference for List Labels in the Read ISO panel to be set to Channel Codes or 

Filenames: this*iso_list_labels 

Read 

• Case 48915 

T/HIS can now read all the columns from the files with large columns. 

T/HIS link 

• Case 49566 

A new Quick-Pick option has been added to D3PLOT to make it easier to display the internal 

and kinetic energy of Parts. When the new option is selected, a linked T/HIS session is started 

automatically and the Energy time histories for the selected parts are plotted. 

 

This new quick pick options is currently only available for Parts and for displaying either the 

Internal or Kinetic energy. 

User interface 

• Case 44793 

Added pop-up option to the FAST-TCF menu for both Create and Run option in case user needs 

to access any old .inp files. 

Added the support for accessing recent directories and files in almost all possible places in 

T/HIS. 
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3.4 REPORTER 

3D 

• Case 30943 

Alongside REPORTER 20.0 is the launch of Report Viewer (https://oasysreportviewer.com), a 

brand-new 3D web viewer for LS-DYNA results. 

Capture 

• Case 50124 

D3PLOT Items have been updated to support the Capture of 3D GLB content from D3PLOT to 

REPORTER. GLB content is displayed using a static image in REPORTER itself but can be 

viewed properly using Report Viewer (and the GLB files created in the job destination can be 

viewed individually using D3PLOT Viewer). When using the GLB (Current frame, 

Uncompressed) option, exporting to PowerPoint is also supported. 

Generate 

• Case 45690 

When writing to PPTX, PDF, or HTML, REPORTER will return to the original page once 

finished. 

Installation 

• Case 49981 

Added the new .ortx and .orrx file formats to the Oasys Suite installer so that REPORTER 20.0 

can be registered as the default application for opening these types of files. 

Powerpoint 

• Case 49043 

A new standard page size, 'PowerPoint slide (Widescreen)', has been added. This new size is 

338.7 x 190.5 mm and matches the 'Widescreen' slide size available in Microsoft PowerPoint 

since 2013. It has the same 16:9 aspect ratio as the older, smaller 'PowerPoint slide (16:9)' size 

(254.0 x 142.9 mm), which is referred to as 'On-screen Show (16:9)' in Microsoft PowerPoint. 

The new 'Widescreen' size should make it easier to create reports that match the latest 

PowerPoint content. 

Preferences 

• Case 49969 

Added support for the oasys*workflow_definitions_directory oa_pref option to REPORTER. 

This preference can be used to point to a user-defined workflows directory. Any 
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Templates/Pages contained in a templates/pages subfolder of the workflows directory will be 

added to REPORTER's list of library templates/pages on startup. 

• Case 10685 

REPORTER now honours the user-defined start-in directory during file selection when a session 

is first opened. When subsequent file selections are required, REPORTER uses the retained 

information about the most recently used directory to help direct the user in browsing. 

Standard templates 

• Case 50192 

Automotive and ICFD Library templates that process D3PLOT items will now automatically 

locate FEMZIP results files (Zd3plot, *.fz) in the results directory you specify. 

Template files 

• Case 50120 

New file formats have been introduced for REPORTER: '.ortx' for Templates and '.orrx' for 

Reports. Using these formats, it is now possible to save multimedia content like MP4 (and the 

newly-added GLB) within your Templates and Reports. The older '.ort' and '.orr' formats have 

been marked as '[LEGACY]' and may be removed in a future release. 

User interface 

• Case 37394 

Added the ability to toggle the 'Active' status of an Item through the right-click context menu. 

Items which are 'Inactive' cannot be Generated. 

Variables 

• Case 49016 

Two new Library Programs have been added: one to delete all temporary variables, and another 

to reset all temporary variables to a specified value (default being to reset to an empty string). 
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3.5 SHELL 

General 

• Case 13160 

Users can now provide a directory location to write out REPORTER log files for their 

REPORTER batch submission. SHELL writes out REPORTER log files for all the jobs in 

submission, in the specified directory. If no directory is specified i.e., if the user leaves the 'Write 

logfile' text field as 'default', then SHELL writes out the logfile in the respective job directories. 

Mpp 

• Case 50412 

We now do not write out u=XTF to SHELL command line for MPP LSDYNA job submission. 

Memory 

• Case 38723 

Fixed SHELL to use less memory while working with large lists of files (like REPORTER lists). 

Preferences 

• Case 50201 

Changed the default value of the MAX_CPUS in the SHELL preferences to 256. 

• Case 36643 

Users can click on 'Save to oapref' button in REPORTER OPTIONS panel, to save preferences 

for 'output and run options' which include combined output options, run reporter iconised, run 

reporter in batch, run d3plot and t/his in batch, automatically exit reporter upon completion. 

Restart 

• Case 46104 

SHELL can now read the 'restart files' for all LS-DYNA versions up to R13. 

Solver 

• Case 49362 

LS-DYNA submission for keyword files with *KEYWORD_ID cannot be given kill commands 

via the SHELL. This has been fixed. 
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• Case 48804 

Added new 'fluids' command line option in Input/Output tab of the SHELL Submission panel. 

This works with the command line preview of SHELL. 'fluids' option is for the R14 version of 

LS-DYNA. 

User interface 

• Case 49704 

If certain files are not present in the installation area, SHELL will now deactivate the relevant 

buttons in the Manual popup menus. 

• Case 46224 

It is now easy to manipulate REPORTER variables in REPORTER batch panel in SHELL. Users 

can add new variables by clicking on '+' button and can remove existing variables by using 'x' 

button. Also, users can add as many variables as they want and manipulate these with a scroll 

list. 

• Case 37871 

The updated REPORTER batch panel is now easier to use with improved button layout. We can 

read in keyword files through directory search, manipulate multiple entries, and insert/delete 

rows in the table section. 

Variables 

• Case 48500 

Users can now declare REPORTER variables temporary in 'Variables' panel with a tick. Users 

can open the Variables panel by clicking on the Variables button in the REPORTER batch panel. 
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3.6 Oasys 

Deleting 
• Case 41391 

Added an Eroded Elements workflow tool to D3PLOT 

- This tool displays deleted elements as specified by the user. 

Javascript api 
• Case 49540 

An OpenManual() function has been added to the JS-API to open the Oasys manuals at a 

specified page, e.g. OpenManual('primer', '3d-pdf.html'); 

User interface 
• Case 48216 

The speed of the graphical user interface (GUI) has been improved. 
− On all operating systems the way that some of the new button and panel decorations are 

drawn has been changed to a faster method, meaning that the 'new' UI (light / dark / 
classic themes) now run as fast as or faster than the 'old' (legacy) theme. 

− On Windows platforms some further optimisation of the GUI graphics have improved 
rendering speed further. 

− On Linux platforms a bug that slowed down rendering when displaying over a network 
has been fixed so that remote rendering using the native X11 display directly back to a 
desktop using the raw X11 protocol' (as distinct from more modern 'thin wire' rendering 
methods) now runs at an acceptable speed. Rendering to a local Linux desktop display is 
also faster as a consequence. 

• Case 47629 

Added a close button to the top right corner of the ambiguous pick menu in PRIMER and 

D3PLOT. And added a cancel button in the information panel for “Don't Ask” button in 

ambiguous pick menu. 

 




